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If you don’t know how to fix a car, you trust your
mechanic. If you don’t know how to fix your tele-
vision, you trust the service technician. But, you
still have choices. That is, if you decide your
mechanic or technician is not on the level, you
can go get a second opinion. This isn’t ideal, but
it is better than having no choices.

We say Linux offers choices. For the most part,
in TUX we have been talking about choices such
as which Web browser or word processor to use.
And, yes, Linux tends to offer more choices than
other operating system alternatives. However, I
want to delve a bit deeper into the idea of choice
this month.

Besides having the choice, for example, of
AbiWord, OpenOffice.org or KWord for a word
processor, you also have the option of making a
change to any of these programs. You have (or
have free access to) the source code of these 
programs, so you can change how they work.

Now, I doubt there are many TUX readers who

are planning to make such modifications, but
having this access goes way beyond what you,
the individual desktop user, may decide you want
to do. It means you have a basic freedom that isn’t
available with many other word-processor products.

Returning to the car analogy, not having
access to the source code would be a lot like
being in a situation where only the car manufac-
turer could open the hood of your car. Although
you might not want to work on your car yourself,
this situation would limit your ability to select the
mechanic you wanted—your only option would
be to go back to the manufacturer.

Why is this so important? Let me offer an exam-
ple of an ongoing investigation in a rather impor-
tant industry—let’s call it the industry of democracy.

In the US, as well as in other countries, com-
puterized vote tabulating systems are replacing
paper ballots. The “marketing hype” is that this
method is better because computers are faster
than dealing with physical documents and more
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Without Open Source, What Are Our Choices
from Computerized Voting Systems?
The results of an ongoing investigation cast doubts on the impartiality of some computerized election results.
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accurate, as “computers don’t lie”.
So, here’s the problem. Computers

may not lie, but they also do not think
or have ethics. They simply do what
you ask them to do. In the case of
something as simple as a two-way
cable TV system, this may mean the
manufacturer of the cable box can
decide the box could report what pro-
grams you watch. Or, your car might
be given the ability to keep track of the
fastest speed you have driven.

Each of these items can be justified by
the manufacturer, but two pieces are
missing here:

� Did the manufacturer tell you this
reporting was being done?

� Do you have a choice?

In most cases like this, the public
seems to find out after the fact, and
then is told it is a good thing. Most
people go along, and all is well—for
some value of well. But, what if a 

software “feature” was being inserted
into a program that reported the infor-
mation incorrectly?

In the case of the cable box, statistics
could be incorrect and give unfair market-
ing advantages to some programs. An
error in a car computer that incorrectly
indicated you had driven at excessive
speeds could result in legal consequences,
if for example, you had an accident.

The check here would be to have
the source code for the software in
these computerized systems available
for review. This means you, the repre-
sentative of a television network or
your lawyer could analyze the program
to make sure it was reporting the 
information accurately.

Back to democracy. The details of an
ongoing investigation related to comput-
erized voting systems can be found at
www.blackboxvoting.org.

There have been many allegations
that various computerized voting
machines were not counting election
results accurately. At this point, the inves-

tigations are well beyond allegations.
Some demonstrations have shown that it
is very easy to cause such machines to
report election results incorrectly.

The biggest issue here goes back to
the fact that the software for these
machines is not open source. That is,
the programming cannot be reviewed
by independent organizations to check
its validity.

Now, is this intentional fraud or
merely poor design? From our point of
view, that of Open Source advocates, it
doesn’t matter. The point is that without
this external review, we simply aren’t
sure it works right. And, as with our
cars, if this is something important in
our life, we should have the right to 
see what is going on.

For you, the desktop Linux user, 
you need to ignore the hype and real-
ize open source is better. It is more
likely that open-source programs do
what you ask, are more secure and,
generally, offer you, the consumer,
more control. And, if you are asked to
vote pro- or anti-open source, make
sure your voting system doesn’t have 
a built-in bias.�

Phil Hughes is Group Publisher for SSC Media Corp.

P2P

4www.tuxmagazine.com

SO, HERE’S THE PROBLEM. COMPUTERS MAY NOT LIE,
BUT THEY ALSO DO NOT THINK OR HAVE ETHICS.
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Earlier this year at the International
Consumer Electronics Show, Google, Inc.,
announced the availability of the beta of
Google Pack. It is described as a free collec-
tion of safe, useful software from Google
and other companies that improves user
experience on-line and on the desktop.
Soon after the announcement, John
Batelle, author of the Searchbog and the
book The Search, commented, “...the
company [Google] has made no secret of
its intention to poke Microsoft in the eye
from time to time.” As it happens quite
frequently in the blogosphere, this phrase
stuck and the Google Pack was quickly
branded as a poke in the eye of Microsoft.
However, I’m not really sure who is getting
poked in the eye.

Of the biggest Internet companies,
Google is surely the leader when it comes
to promoting Linux and open source.

From standing out as a clear innovator by
leveraging the power and reduced total
cost of ownership from running Linux in
its massive server farm to sponsoring the
Summer of Code, there is no mistaking
that Google is a friend of Linux and open
source. Tim O’Reilly, founder and CEO of
O’Reilly Media, is fond of sharing this
observation. Many people, when you ask
them, swear they never have used Linux
or open source. But if you ask them if
they have used Google, they will say, “of
course”. At which point you can tell
them that if they have used Google, then
they have used Linux and open source.

NO END-USER LINUX APPLICATIONS
The problem is that Google Pack is not
available for Linux. Although Google Pack
includes many third-party applications,
some of which might be available for

Linux, the bulk of the software available
was purchased or developed by Google.
Of the five applications Google Talk,
Picasa, Google Earth, Google Desktop and
Google Pack Screensaver, none are avail-
able for Linux. Many industry experts posi-
tion Google against Microsoft in terms of
competitors. So, to me, when you make
announcements for products that require
the foundation of your competitor’s prof-
itability, you are not poking them in the
eye. You are poking yourself in the eye!
Conceding the operating system level to
Microsoft is one thing, but actively mak-
ing products that require your competi-
tor’s products is foolish and shortsighted.

If Google were building a Linux version
of these applications, that would be the
kind of news I would like to hear. I’m seri-
ously hoping that these developments are
in progress, and that Google is remaining
quiet until the right time. Recently, a
rumor surfaced that Google was working
on an Ubuntu-based distribution.
However, Google resolutely denied that
rumor. One of Google’s key strategies is to
corner the market on the brightest scien-
tists and engineers. So if Google is moder-
ately successful with this strategy, the rea-
son it has not released any Linux software
applications can’t be due to a lack of tal-
ented resources. Although I might be
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It’s All Fun and Games Until
Someone Gets Poked in the Eye
By announcing Google Pack, is Google, Inc., following a Windows-centric strategy, despite
signs that globalization will carry Linux into every under-developed corner of the world?

KEVIN SHOCKEY
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widely mistaken, the lack of Linux software
available from Google is the result of faulty
strategy and lacks a critical understanding
of the software marketplace.

A NEW GLOBAL MARKET?
Anyone familiar with Thomas Friedman’s
work will readily agree that a globalized
marketplace has been emerging that will
bring incredible change. When we consid-
er that the majority of the people in the
world have never seen a computer, surfed
the Internet, used Microsoft Windows or
searched Google, it leads me to believe
that it is paramount to ensure that the
first computer they do see runs Linux.
Due to the stark differences between pro-
prietary and open-source software, many
of the countries where all these potential
customers inhabit will demand Linux. But
what about the others? Is Google also
willing to concede all of those potential
customers to its competitors?

If there is any doubt where the market
is headed, consider an announcement
made by Mandriva in January 2006.
Mandriva, publisher of the popular
Mandriva Linux operating system, has part-
nered with HP to distribute HP computers
preloaded with Mandriva Linux 2006 to 37
countries in Latin America. The companies
will work together on sales, support and
marketing in all Latin American territories,
including Brazil, Argentina and Mexico.
The first of these preloaded machines has

already begun shipping.

CORE OR CONTEXT
As Google rolled out some these applica-
tions, many wondered what does this prod-
uct have to do with indexing the Web and
serving context-sensitive advertisements?
Geoffery Moore, in his book Living on the
Faultline, outlined the concept of core versus
context. His premise was that successful
companies focus their efforts on service and
products that differentiate their offerings in
the eyes of the customer; everything else is
context. So what is Google Pack? Is it core
or context? One opinion shared within the
industry is that anything Google might do
that helps end users manage and find infor-
mation is core. This popular opinion also
concludes that if Google can become
involved with the management and index-
ing of information, all paths lead back to
them—that is, it will find a way to put a
context-sensitive ad beside that information.

This strategy is confirmed with Google
Talk. When it was originally released as a
standalone client, there was no way to
index or include advertising. Recently, how-
ever, Google announced Gmail Chat.
According to Google, it is the first integra-
tion of e-mail and instant messaging in the
browser that offers users a seamless com-
munications experience. One of the fea-
tures of Gmail Chat is that the logs from
instant messaging sessions will now appear
within the Gmail browser interface. Of

course, this now means that Google can
place ads beside those log sessions.

So even if it might not be clear now, it
certainly seems, that with these products
all paths do lead to Google. My concern
is that in the process of forging all of
these new pathways, Google doesn’t
accidentally create them in ways that
force us to pay a toll. If these applications
(that Google wants everyone to get
hooked on) are not available on Linux,
Google will be doing more than poking
themselves in the eye when we choose
not to use its paths. When everyone
around the world finally does get a com-
puter and joins us on the Internet,
Google might discover that it built path-
ways for today, when it could have been
building expressways for tomorrow.�

Kevin Shockey is Editor in Chief of TUX.
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EDITOR’S NOTE

Before going to press, I learned that
Google and CodeWeavers are working
on a version of Picasa. Although the
result will not be a Linux port of the
application, but rather the combina-
tion of Windows Picasa code and Wine
technology to run Windows Picasa on
Linux. Nonetheless, it is still a move in
the right direction.

http://www.tuxmagazine.com
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Editor’s Note
With more than 50 responses, the verdict is clear.
We need to put together a searchable index of
TUX issues. I’ve spoken to the Publisher, and we
agree that an index is a great idea. The big ques-
tion now becomes, when and how. Well, we have
quite a few exciting changes in progress and a
busy schedule, so it’s hard to estimate when
something will be available. In the meantime, if
you have Beagle, you can build your own search-
able index of sorts. Put all of the issues together
in one directory, and use Beagle to search that
directory. I tested this configuration, and it
worked for me while answering these letters.

PCLinuxOS Helps Solve 
PSP-Compatibility Issue
I am writing in response to an entry in the Letters
section of your magazine [“An Issue with Sony
and PSP Compatibility”, February 2006].

I use a Mandrake-based distribution called PCLinuxOS
with my Sony PSP and it works fine. The latest version
is PCLinuxOS .92. Not only does this distro work very
well with my Sony PSP, but it autodetects and
remounts the Sony PSP every time after removing the
USB connection and plugging it back in again.

PCLinuxOS will work fine with the Sony PSP, and the
PSP will recognize the files as being present.
However, with that being said, you don’t want to be

quick to switch out of USB mode on your PSP after
transferring files from the computer, because even
though it may look like it has completed on the PC
side, the PSP may still be processing the transfer. You
want to make sure the progress indicator on the PSP
(which bounces from left to right to show activity)
has disappeared. After that, you are good to go!
—
Joseph M.

Praise and Frustration from India
First, some words of congratulations are due. TUX is
the best Linux magazine I have ever seen. I am
somewhere between a geek and an average user. I
found the articles unbelievably interesting for me. I
want to share some thoughts with you. Six or seven
months ago, I seriously started using Linux, and my
impression of it has been better since then.

There are some things that I am still uncomfortable
with, but I will talk about them later. Currently, I’ve
been trying to convince some Windows users
about the wisdom of using Linux. Some people
were interested, but all of them had the impres-
sion that using Linux is difficult, and to the best of
my ability, I was not able to convince them that it
is not true. I think that is because they are used to
Windows, and they feel at home with Windows.
As Linux is different, they feel uncomfortable, and
not many have the willingness to learn anew.
There is very little we can do about it.

What I see all around is that most Linux users are
“converted” from Windows. (This is in spite of the
above fact—I am one myself.) So, I think it is very
important that we should have a lot of young
users who will see and learn Linux first. In most of
the places where people learn to use computers—
like in their institute or some computer-training
school (this is especially true here in India), we
should have more of Linux to offer them. Can you
share your views about this?

Now about the flip side of Linux—I find administrat-
ing a Linux system a frustrating business. I am doing
my research and am generally busy. Often I don’t
have much time or patience to go through articles
on how to compile programs. The way Windows
installs a new application, by assigning a new folder
in the filesystem for the program and keeping all
the components of the program in that folder, is in
some sense a good idea. You don’t get conflicts
that way. I’m looking forward to some thoughts on
this in your editorial column. By the way, thanks for
the articles on klik and autopackage.

One more question: can you tell me about any
graphical mathematical program like origin that
does data plotting on Linux? I tried using MATLAB
and OpenOffice.org Calc, but they are not up to
the mark.
—
N Arju

LETTERS
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Thank you very much. We think we’re the best
too, but it’s still nice to hear from our readers.
We share your frustration, and one of our pri-
mary goals is to dispel the myth that Linux is
difficult. I personally share your frustration with
installing applications in Linux, so much so that
it will be the subject of my next column. About
MATLAB, I worked with a student whose mis-
sion was to convince every engineer that would
listen to him that Python along with various
libraries was not only as good as MATLAB, but
that it was better, because it saved users from
the large licensing fees associated with MAT-
LAB. From our conversations, there should be a
wealth of information available on the Internet
comparing the two.—Ed.

Feeling the Pain from Linux
Application Installation
Personally, I find the biggest pain at the moment
is loading/updating software. The issue of tar-
balls is somewhat of a Black Art, and, dare I say
it, one of the areas where M$ does beat Linux
hands down. OSDL really does need to put this
one near the top of the list. It’s all very well
phaffing around with drivers, but if you can’t
load the software in the first place, the drivers
are not worth a can of beans.

For example, I want to look at a Web site that
requires Firefox to have a Shockwave plugin installed.
Frankly, I have given up and use a Windows XP
machine to do it, because it is such a laborious task

and I am not sure if I know what I am doing. I am
not going to risk upsetting my e-mail/Web surfing,
as I already managed somehow to turn off JavaScript
under Xandros, and despite the best efforts of a
number of “gurus”, have not managed to undo the
damage. I can log on as a different user on the same
machine and have no problems. If I need to do it for
Firefox on a Windows machine, it’s just a couple of
clicks and it’s installed.

Things I find hard (different) with Linux:

� Filesystem—so I’m a slow learner.

� Locating my various drives/files.

� Installing/updating software: kernel, GUI, Firefox.

� Getting some “gurus” to talk to me in a lan-
guage I can understand. I don’t think I am a
total Numpty, as I did my time with the
TRS80, DOS and made my own PC from
parts back in the 8088 days! I have even
used punch cards for programming, which I
guess dates me somewhat!

� Downloading and burning CDs of distros.

Oh, by the way, I saw IceWM running as a desk-
top, and I think it is something you could do an
article on. Keep up the good work.
—
GerryAttrick

Another one of our goals is to provide advice in a
language that is accessible to everyone interested.
As mentioned above, stay tuned until next issue
for more on these subjects.—Ed.

Difficulty Getting Multiple
Distributions Installed
I am new to Linux and am trying different 
distros to see what fits best for me, and I can’t
seem to be able to boot different installed 
distros. I can boot only the last installed one. 
In the November 2005 issue, Nicholas Petreley
explained how to do it. I have tried to follow his
instructions on how to set up multiple boot
options, but I can’t quite get it to work properly.
At the moment I have:

� hda1: primary partition 78MB for booting.

� hda2: swap partition.

� hda3: primary partition for Linux /root.

� hda4: primary partition for /home.

� hdb1: second Linux OS.

� hdb5: swap.

I can see the menu.lst for each Linux OS 
and can run each OS after installation. I also
can see that the menu.lst in hda1 is the same
as in hda3. I have added the correct lines 
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from menu.lst in hdb1 to hda1. But, I cannot
seem to boot from hda1. When I try to do:

grub> root (hd0,0)

I get:

Filesystem type unknown, partition type
0x6.

If I ignore that and do:

grub> setup (hd0)

I get:

Error 17: Cannot mount selected partition.

I am stuck and don’t know what to try. Any
suggestions would be appreciated.
—
Chris Andreae

iPod Support from within Linux
I have been reading your magazine from issue 1,
and I really like it. Congrats on making such a
wonderful magazine. It’s a great magazine made
possible by a great team.

I have an iPod shuffle (1GB) and would like to
know how to upload music onto it from my
Mandrake 2005 LE (10.2) desktop. Right now, I
use iTunes on my sister’s Windows machine to

load the songs onto my iPod. Is there some-
thing similar to iTunes that runs on Linux? Your
input would be appreciated.
—
Kaizer

Check out the June 2005 issue for help with this
problem.—Ed.

Squeezebox Offers the Sonos Digital
Music System a Run for Its Money
I enjoyed the article on Sonos [February 2006].
I’ve seen advertisements before and was a 
little curious about it; however, Linux users
have more than one choice for this kind of
music gadget.

Slim Devices produces the Squeezebox, a small
device that connects to your home music sys-
tem and receives streamed music from your
home network. The server software is open
source and runs on Linux, Mac and Windows.
You can have multiple Squeezeboxen streaming
different music from the same server, and one
remote would suffice for each unit, but you get
the remote included with each Squeezebox.
You also can connect to the server through a
Web interface.

The Squeezebox handles MP3, Ogg Vorbis and
some lossless music formats. Plus, you also can
stream Internet radio through your Squeezebox
to your home music system with just a few

thumb twitches on the remote. You can get
your Squeezebox with an Ethernet port or an
Ethernet port and wireless antenna. You also
can use the Squeezebox to connect other
devices to your home network. For your audio
connection, you can use either an optical or
analog output.

There are a few things the Squeezebox can’t
do that the Sonos can do, but then, the
Squeezebox is much less expensive. But, even
better, you can download and install the server
software (Slimserver) for free. It includes a pro-
gram called Softsqueeze that you can use to
put a virtual Squeezebox on your computer
desktop, including a “remote” with buttons
you can click with your mouse. It operates 
just like a Squeezebox, so you get a free test
drive you can keep, even if you never buy a
Squeezebox.

There is an active community of users on-line
who produce cool plugins and help each other
get the most from their music. Slim Devices is
decidedly a friend of free and open-source
software. If you’re looking for a way to con-
nect your hard drives to your music system, the
Squeezebox is a great option for Linux users.
—
Damon Riley

Thanks for the heads up on Slim Devices and
Squeezebox.—Ed.

P2P
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A Call for More Security-Focused
Articles, Maybe Even an Entire Issue
Linux, free and secure, is fast becoming a 
popular choice for secured public computing
environments. Live CDs provide an excellent
solution for read-only computer access, but for
those who would like to deploy a more flexible
HD-install Linux solution, there is a complete
lack of DeepFreeze-esque software for Linux.
Faronics DeepFreeze restores the initial image
of a hard disk upon reboot, so that even a 
user who bypasses security settings cannot 
permanently affect the machine. It may be 
possible to create a DeepFreeze-esque solution,
system-wide or for specific accounts, without
special software, through tmpfs, unionfs or 
init scripts. Proprietary solutions like Userful
Discoverstation seem to have it figured out.
Any ideas? There are lots of people like me
looking for something like this.
—
Luke

Praise for TUX’s Landscape-Friendly
and Electronic Format
I just opened the February 2006 issue of your
magazine and read all 56 pages. I was really
pleasantly surprised at how good the pages
look—all the text and graphics are sharp and
hi-res with Adobe Reader 7 on my SUSE
9.3/KDE desktop. I can actually read the pages,
obviously formatted for my 4:3 ratio video 
full-screen, even without glasses.

I just bought a 681-page PDF book on AJAX
and it is formatted like a book not like my
screen. As such, is it awkward. I expected the
same of the TUX PDF, but it is quite easily read.

I will always take the 20-second download of
this file over the stacks of printed magazines I
throw out every month. Printing costs money
and trees. Besides, the PDFs are searchable
within a directory. Keep up the good work.
—
Alan Gruskoff

Sincere Thanks for TUX
TUX deserves a pat on the back. Your magazine
helps calm the nerves of new users nervous
around this new thing called Linux. I believe
that your magazine and others like it, if others
exist, will play an important part in bringing
others over to the penguin side. I was just read-
ing the Letters section in TUX [February 2006]
and read someone’s account of being asked
whether Linux has software to do this or that.
It’s true that many people don’t realize what’s
available and especially how well it works.

Your articles offer step-by-step instructions and
explanations on the software being reviewed. In
some cases, your explanations make more sense
than the ones that come with the software. I
have tried many software packages after read-
ing reviews in your magazine. I look forward to
every issue and keep them all for reference.

To make a long story short, I just want to 
offer my sincere thanks to TUX for doing 
what it does best, instructing, explaining and
promoting Linux.

By the way, I converted to Linux almost one year
ago and have not regretted a moment. It’s been a
great learning experience.
—
Stan Cook

April Distro Smackdown Edition
Please include the new Xandros desktop now
under beta testing. I have the 3.0 standard ver-
sion, which is quite good, but I hear this next
one is much improved, and it would be unfair to
use the 3.0 in a comparative review of state-of-
the-art Linux desktop OSes. By the way, TUX is
great, and I’m looking forward to the planned
2006 lineup. Good luck in your new job.
—
DH

Many thanks. The Smackdown issue is shaping up
to be a real knock-down, drag-out issue.—Ed.

Request for a Review/List of Ogg
Vorbis-Compatible Devices
In past articles, you raved about the Ogg file-
format. “Freedom and quality”, you said.
Regarding the quality, I agree: you get smaller
files with the same or better sound quality (com-
pared to a similar MP3 file). Regarding the free-
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dom, I took a look at some MP3 players at a
popular Web shop, and it did not seem that
Ogg support was common, especially among
the cheaper players. A review/list of MP3 players
that support the Ogg format would be nice.
—
Uriel

Thanks for the great suggestion, I’ll talk to the
Gadget Guy and see what we can come up
with.—Ed.

Request for an Article to Set Up
Creative Zen Players in Linux
Being a recent Linux user, I have found your
magazine to be very useful and interesting. I
found in particular your article on connecting
an iRiver to Linux to be of interest [October
2005], but as a dedicated user of Creative Zen
players, I would be very interested if in the
future you did an article on setting up libnjb
and the various software available, either gnomad
or kzenexplorer.

Again, thank you for producing an interesting
article for people just starting to look at Linux.
—
Gavin Blackford

Where Linux Falls Down and Can’t
Get Up Again
As a relatively new Linux user (about six
months), I have found several areas where
Linux needs to be improved. The first is hard-
ware drivers. Although Kanotix identified and

set up most of my hardware automatically,
modems, video cards and printers can be prob-
lematic. Fortunately for me, my old HP Deskjet
712c is supported (I had to install a driver
using the included printer management utility).
It appears that many new printers do not have
any type of Linux drivers or support whatsoev-
er. The same applies to many modems. The
best thing that dial-up users can do is get an
external modem. Even then, it is still best to
check for compatibility with Linux before buy-
ing. Although Kanotix set up generic video 
settings that work for most programs, card-
specific video drivers are needed to provide 3-D
acceleration and activate other special features
of some video cards. We Linux users need to
demand that easy-to-install Linux drivers are
developed for all hardware.

PS: I have what might be a good idea for a
TUX article: explain why you should not log in
to Linux as root unless it is absolutely neces-
sary. I understand the security (and other)
issues, but some had to be explained to me,
and others I read about in the Kanotix forums.
Most computer users migrating from Windows
to Linux do not understand why they should
not log in as root all the time, as in Windows
you basically have root privileges all the time
(along with practically no security!).

PPS: people need to stop whining about the
comparisons between Linux and Windows. These
comparisons give people an idea of the features
and limitations of the operating systems and

software being compared. Micro$haft bashes
and even lies about Linux all the time. So don’t
get so upset if Linux fans bash back a little!
—
Martin

Yes driver compatibility is a problem. However, I’d
like to reiterate a comment of Mango’s this
month. When assessing new hardware, please
place the availability of Linux drivers as the first
criteria. The only way to change manufacturer
behavior is to vote as effectively as possible. When
we purchase Linux-compatible hardware and
peripherals, there is no more effective vote.—Ed.

Linspire and TUX Disappoints in
Australia
First, I would like to say that I think TUX is great.
The features discussed on the different software is
fantastic, interesting and inspiring for a newbie
like me, but I have one gripe! TUX proclaimed
Linspire as the easiest and, dare I say, the best
Linux version available for newbies.

Well, on the strength of that argument, I went
and bought Linspire and subscribed to CNR
Gold, and so far it has proved no better, and in
fact far worse, than some of the other versions
of Linux I have tried. As you can imagine I am
disappointed in Linspire and as a result, a bit
peeved at TUX.

I initially encountered troubles in purchasing
Linspire. I went through the rigmarole of typing in
my e-mail, credit card, etc., and then lockup. By
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lockup, I mean that once I entered these details I
could not progress to whatever the next field of
entry held, nor did I receive a response to
acknowledge my entries. Again I tried, and again
the same problem. I sent e-mails, and eventually
an e-mail reply told me that my payment had
been received and my receipt was included. I sent
more e-mails asking how can I download my now
paid-for version? Where is it? What do I have to
do now to get my copy of the OS?

No reply forthcoming, so I went to the Linspire
Web site and logged on and found that I was able
to download my copy. Hey! I hear you say, this
dummy finally worked it out for himself a week
later after paying his dollars. I did download my
copy and burned the CD and loaded it on, and it
was nearly as good as the live CD version—or so I
thought at the time.

But then my problems started to compound.
Linspire comes in a very basic form, so I sub-
scribed to CNR GOLD (as previously mentioned) to
enhance the distro. But, silly me—I was now
unknowingly embarking upon a nightmare. I tried
to set up the desktop to have six virtual desk-
tops—no go (yet using the live CD this was possi-
ble). So, I tried to have only two desktops—again
no go. I sent an e-mail, and I’m still waiting on a
response after four days.

Ah! I thought—the CNR updates available is flash-
ing at me—hey! Just do it (I thought). Go for the

software updates. Big mistake. What a fool.
Downloads commence, program recommends
install of such and such, and then the error mes-
sages start coming and coming and coming. This
newbie is pulling his hair out now with more than
two hours of error messages and having copied a
few of these error messages to paste into e-mails
for Linspire customer service to read and help me
out. Alas, three hours of this, and I finally gave up
and switched off my PC.

I could go on to explain many other niggling
problems I find with Linspire that I didn’t find with
other Linux versions I have tried, but I’m
depressed with the distro enough as it is, and
after more than three weeks of this, enough is
enough. Linspire is a vexing OS. Or, is it me? I
swallowed the hype of CNR (Click ’N’ Run), and I
regret it. I will try for a refund, though I doubt I
will get a reply.

In my opinion, I have had a gut full of Linspire. So
it seems at this point in time, I will be saying
good-bye to Linspire and good-bye to my dollars
and come back Xandros (forgive me for deserting
you—the grass was not so green on the other
side—even though I was totally green).
—
ken

Sorry for your experience, but we did say that
Linspire was far from perfect. However, it is an
excellent point that part of the usability of a

distribution is the experience of obtaining that
distribution. Hopefully, by printing your letter
in its entirety, Linspire will take a look at the
concerns you raise.—Ed.

An Inquiry about the Editorial
Calendar
Thanks for your 2006 Editorial Calendar. I’m look-
ing forward to the August 2006 Linux Media
Center Issue—I think this was originally scheduled
a year ago, but pulled without explanation. When
I inquired what had happened, I was told it was
because of “advertising issues”. So, is this calen-
dar set in stone? Can I look forward to the
August issue? Thanks for a highly readable and
relevant publication.
—
David Jenn

You’re welcome. I can’t really speak about
what happened before, but I assure you that I
have every intention of following the editorial
calendar exactly as written. That said, nothing
is set in stone, look at what the Colorado River
did in Arizona. Looking forward, I’d like to
receive issue suggestions for next year. Send
them to ed@tuxmagazine.com.—Ed.�
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Bunny annoys me all month this
month. It is not her hang-up with
armadillos that annoys me. She talks
too much. I do not like it when people
talk too much. I do not talk too much.
I know when to stop talking. Just tell
me when to stop talking and I will
stop talking. I know when someone is
hinting. I do not need a brick to hit
me to know when I am talking too
much. So just hint to me that I am
talking too much and I will stop. I will
stop right then. I will not go on and
on until you are bored and fall asleep
waiting for me to find the hint that I
am talking too much. I am not like
Bunny. I stop right away. I am like that
when I write too. Just tell me when I
am writing too much and I will stop
writing. I will stop in the middle of a
sentence if I need to. I am not stupid. 
I know what it means to write a little
and write too much. I know when to
stop. I wish Bunny would learn when
to stop. I would be happier if she
knew when to stop like I know when

to stop.
You have sent me so many ques-

tions this month I do not know where
to start! I am so happy you are send-
ing me so many questions. I do not
have to worry about finding good
questions for months, even if nobody
writes to me for a long time. That
does not mean I do not want you to
write to me. I want even more ques-
tions so I can make any choice I want
on which question to answer.

Q I’ve had Ubuntu 5.10 installed on my
computer for some time, dual-boot-

ing between that and Windows XP.
Recently, I have upgraded my network to a
wireless one. I have installed a D-Link
DWL-G122 network adapter on my system,
which works fine on XP but unfortunately
is not recognized under Ubuntu. I was hop-
ing to run only Ubuntu on my system, but
until I get this wireless adapter working,
I’m stuck in a Ubuntu/Windows dual-boot.

I’ve done some research, and I found a
program called ndiswrapper and tried

installing it. I found the installation very
complex for a novice like me, and need-
less to say, I was not successful. Do you
know of a simpler way of getting my net-
work adapter working?—Ken

A No.

I’d like to stop there, but I do not
like to pass up the opportunity to scold
people. You run Linux. So why do you
buy a network adapter that does not
have a native Linux driver? This does
not make sense.

You are not stuck. Here is my advice.
Return the D-Link adapter and exchange
it for a network adapter that has a native
Linux driver. If you cannot return the
adapter, buy a new one anyway.

Call D-Link or write to them. Tell them
that you are very unhappy because you
bought this adapter and it does not work
with Linux. Tell them you will tell all your
friends that D-Link is like sushi with para-
sites so do not buy D-Link products. Tell
D-Link the name of the company of the

Mango is Adept at fixing problems with proxies, panels, partitions, scolding people and much more.
MANGO PARFAIT

Q&A with Mango Parfait

http://www.tuxmagazine.com


new one. Tell them how much you love
the other company because it makes an
adapter that is just as good as DWL-G122
but works with Linux. Tell them you will
tell all your friends about this super com-
pany and this super adapter.

If you do not buy a new adapter, the
only way to get this one working is to use
ndiswrapper. It does work with ndiswrapper.
Like you say, it is not easy. You can find
instructions on how to use ndiswrapper in
the November 2005 issue of TUX.

Q Hi Mango. Because you are partial to
KDE, I think you can perhaps be so

kind as to point me to where the error lay.
What error you ask? The problem is that it
seems that I lost the taskbar along the
bottom of the screen in KDE (KDE insists
that it is present and accounted for).
Mmmm, perhaps a little more info will
help. I am running SUSE 10.0_64, using
both KDE and GNOME (sorry Mango, but
variety is the spice of life). I cannot
remember what I did or tried to do, but
the result was the loss of the taskbar. I
cannot find it, nor can I find any setting to
return it. I have created a new taskbar and
populated it with the most used icons.

When minimizing any window at pres-
ent, it simply disappears to the invisible
taskbar, and I’m unable to recover the
application. When trying to open Firefox

or Kinternet, I get a message that insists
that both are running and that Kinternet is
the green icon on the (invisible to me)
taskbar. So, at present, I use GNOME to do
most of my work (yes, I thought that
would offend your delicate sense of right).
Speaking of GNOME, is there a way to
change from double-click to single-click in
GNOME? I detest double-click, as it seems
so “Windows” and is a waste of energy.

On the subject of desktops (it seems
I’m going to rain on your parade) take a
look at https://lg3d-core.dev.java.net. Very,
very nice. Now if I can just get it running.
Thanks for all.—evert

A I do not have a 64-bit computer. I
think I may buy one soon. I am

sweet and delicate. I like power. I like this
combination. I hope to be a sweet and
delicate tyrant someday. It is good to
have a dream.

When I can afford to buy more power,
I probably will buy a computer with the
dual-core AMD 64. But now I do not have
one. So I cannot try to make the same
thing happen on my PC that is happening
on your PC.

I can make the panel disappear on my
system, so I will guess that your problem
is like the one I can make happen.

Here is how to fix the problem I can
make happen. Right-click on an empty

space on the panel you can see. Select
Configure Panel... from the pop-up
menu. You will see a window like the one
shown in Figure 1.

Pay attention. Your window probably
will not say Settings for: Main Panel.
This is good. Check the boxes like I
have them checked. Check the box for
Only hide when a panel-hiding button
is clicked. Check the box for Show right
panel-hiding button.

Now click on the drop-down control
next to Settings for: and select Main
Panel. Check the boxes like I have them
checked. Check the box for Only hide
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when a panel-hiding button is clicked.
Check the box for Show right panel-
hiding button.

If your problem is the same as the
problem I made myself, it should be fixed.

I made the problem happen by mak-
ing two panels without hide buttons
and told KDE to hide both panels auto-
matically. When I do this and move the
mouse to the panel spot, KDE makes
only the second panel appear. It should
not be possible to make the first panel
disappear forever in KDE. Somebody at
KDE must write code to make sure
nobody makes this happen by accident.
But KDE should not take away the
options. They should just write code to
make sure that users cannot hide the
main panel forever by accident. That is
the right way to fix the problem.
GNOME uses the wrong way. GNOME
developers think “Users are too stupid
to use fancy features without getting
into trouble. We are too lazy to make
sure these features will work without
users getting into trouble. So we just
remove them.” Maybe I am wrong.
Maybe they are not lazy. Maybe they
are just tired because they have Mono.

Thank you for the URL, but I already
know about Project Looking Glass. It
looks very nice, but it is never finished.
It does not run on my Kubuntu system.

The developers are slow, but I hope
they do not think like the monkeys who
make monkey-brain GNOME things like
the GTK and GNOME file load and file
save dialog.

Q Re: your answer in issue 10 of TUX
about floppy disks in Ubuntu Breezy.

Yes, you are right, it’s broken! But there is
a slightly better method for solving the
problem than the one you gave. Instead of
using mount, use pmount. That way you
don’t have to mess with /etc/fstab.

I have added two icons to my toolbar.
One runs a small shell script:

#!/bin/bash
pmount /media/floppy
nautilus /media/floppy

This mounts the floppy and opens it in
Nautilus.

The other icon simply runs the com-
mand umount /media/floppy.—Andy B

A This is not a question. It is an
answer. It is a good answer. I hope

the people who are wise enough to
read my articles will read this answer.
Thank you. But do not get any ideas
about taking my job. I need the money
to buy more shoes. No, Bunny, I do not
want armadillo leather boots. Sorry, my

friend Bunny is here reading my
answers and she thinks I should buy
armadillo leather boots.

Q Hello there, I have test-installed
Kubuntu under VMware (Windows

version) on a company computer, and I use
it behind a firewall and a proxy.

Adept doesn’t work—it seems it does-
n’t get a connection. When I start the
updater it remains on 0%, getting pro-
gram headers for a while and then returns
without an error message. I started sudo
apt-get update on a console, and it
behaves the same way (at least it reports
a timeout error).

Is there a way to tell Adept about the
proxy and which port it should use?
Thanks in advance for your help.—L
Jerren

A Adept does not have settings for a
proxy. You are lucky. Adept uses the

same settings as apt. So you can set a proxy
for apt, and it will make your problem with
Adept and apt-get go bye-bye.

Press Alt-F2 and start your favorite
editor with sudo. For example, type
(change the word editor to the name
of your editor):

sudo editor /etc/apt/apt.conf
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The file /etc/apt/apt.conf does not
exist in Kubuntu. So, you will not see
anything when your editor starts. Type
in this text. Change the word squidproxy
to the domain name or IP address of
your proxy server. I do not know if your
proxy is squid but my example is for
squid. So, my port is 3128. If your proxy
uses a different port, change 3128 to
the port for your proxy:

Acquire
{

http
{

Proxy “http://squidproxy:3128”;
}

}

Save the file and exit. Now you can
use Adept or apt-get. If you use FTP
repositories too, you must add a sec-
tion for FTP like the one for HTTP. I do
not use FTP repositories because they
are slow for me, and some proxy
servers make it very hard to get FTP to
work. If you want to use FTP, you must
study the options for apt.conf to learn
about all the many settings you can try
to make FTP work. It is easier to use
HTTP and not FTP.

Q Dear Mango, my primary distro is
Ubuntu (Breezy for now), just like

many others. However, my old laptop
cannot bear the load of GNOME or KDE
(possible but too slow). So, I set up a
server installation, and later installed
IceWM as my desktop.

My problem is this: if Dapper Drake
comes out, it would be ready with GNOME
and KDE, but IceWM may not be ready at
the time. If I upgrade my distro at that
time, I might get stuck with the command
line if there is no compatible IceWM avail-
able. But, I can know whether IceWM is
available or not only after setting up the
new upgrade together with Synaptic.

I met this problem when I upgraded
from Hoary to Breezy too.

How can I avoid it with the future
upgrade?—Ven. Pandita (Sri Lanka)

A Here is how I would check. Run
Synaptic and change all your

repositories from breezy to whatever
the new name will be (dapper? I do 
not like this name). Click the Reload
button on Synaptic and then search 
for IceWM.

Do not forget to change your repos-
itories back to breezy when you are
done. Then, click the Reload button on

Synaptic again.
If you do not like this answer, try this.

You can get a live CD version of Ubuntu
and Kubuntu. Create a live CD and boot
this CD. You can run a package manager
on GNOME or KDE on the live CD and
use it to see whether IceWM is available.
If this is too slow for you, do not load a
window manager. Go to the command
line and type:

sudo apt-cache search icewm

If you see IceWM and a list of IceWM
support packages, you know IceWM is
available. It is possible that IceWM is
available, but you do not see it because it
is stored in a special repository.

Q Dear Ms Mango, I love Linux pas-
sionately (Mepis especially, though

there are so many great choices) and
would like to be using it right now to type
this e-mail to you but I have this,
well...problem.

I need to make regularly scheduled,
whole-drive backups—images—much
like I do with Acronis TrueImage or
Norton Ghost when I use Windows XP.
Can you recommend any software for
Linux (free or otherwise) that will allow
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me to perform the same hassle-free
imaging experience I have with those
two programs? I have overcome most
other stumbling blocks that prevented
me from committing totally to Linux
from Windows, but this one remains,
and I am certain there is probably a
simple answer to this problem. I’ve
Googled the problem and done some
other reading, but none of the “solu-
tions” I’ve found seem like they would
perform what I need them to do, the
way I need them to do it.

Thanks for any help in advance; I
think we all will see how much a bless-
ing Linux is (no matter what distribution
you like) once Windows Vista comes to
market. I just want to make sure I’m
ready for the complete transition to a
humanistic operating system that allows
me to do what I want, the way I want,
when I want.—Ed

A I am not sure I can give you a
good answer. I do not use Acronis

TrueImage. I do not use Norton Ghost.
So, if I do not know about these pro-
grams, how can I tell you about a Linux
program that does the same thing? I
do not know what the same thing is.

The one thing you say is that you

want to make backups. I will guess that
you do not need to take an image you
make from one drive and put it on
another drive that has a different size.
That is a different thing from backups. I
will guess that you want to create an
image that you can use to restore data
back to a drive that is the same size.

Maybe you want to create an image of
a whole disk, even if the disk has many
partitions. If you want to do this, try the
dd command. Here is an example.

You need to be root to do these
things. Unmount all partitions on the disk
you want to back up. Maybe this disk is
/dev/hda. Then, type the command:

dd if=/dev/hda of=name_of_image_file

This copies the whole disk /dev/hda to
the file named name_of_image_file. You
can use dd to copy the image directly to a
tape or another backup device. You must
know information about the backup
device to do this, so you can set the
parameters for dd to know how to send
information to this backup device. I do not
know anything about your backup
devices. I cannot tell you what parameters
to use. Read the man page for dd to study
the different options. The command is:

man dd

I do not use dd because I do not back
up drives. I back up partitions. I also do
not like to back up empty space.

I use a free, open-source program
called partimage. You can get partimage
for almost every distribution. partimage
will copy the data from a partition and
not the free space on that partition. It
can compress the data to create a smaller
image file.

partimage does not restore data to a
partition that is a different size. But, you
are talking about backup and restore, so I
do not think that is a problem. I never
have problems using partimage with ext3
partitions or reiserfs partitions. It saves
ntfs partitions, but I have never tried to
restore an ntfs partition. I do not know if
it can do that without mistakes. XFS has
its own backup and restore programs, so
I do not recommend using partimage
with XFS partitions.�

I am a sweet, humble, delicate and very cute genius
who is at your service to answer your Linux questions.
Send your questions to mango@tuxmagazine.com. I
am deeply sorry that I do not have time to respond to
anyone directly by e-mail, but I will select as many
questions as I can and answer them here.
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Last month, we took you through the basics; this
month, we do the advanced/fun stuff. Instead of
the boring old drumkit and the same old sound,
we trigger notes by the keyboard, add accents,
change the acoustics of the kit, apply external
effects to the current sound, import new drumkits
and show you how to make your own.

KEYBOARD PLAYING
Instruments can be triggered using the keyboard,
which means you can play around freely and place
the notes by feel, instead of textbook-like compo-
sition. These notes also can be recorded with the
Record button in the recording section at the top
of the pattern editor (see the manual for a key
reference). If you are having trouble keeping
things in time, the Q (Quantize keyboard/midi
events to grid) button in the recording section
snaps each note to the grid for perfect timing.

If you define your own set of eclectic samples, you
can trigger them live via the keyboard during a music
recording. Ultimately, it’s up to you how far you want
to push the program, and you may even get it to do
new things that were previously not imagined.

SONIC MANIPULATION
Last month, I briefly mentioned randomize veloci-
ty, which randomly changes how hard each note
is played to provide a more human feel. This
month, we have a whole section dedicated to
making the sound more dynamic and human, as
well as changing the acoustics of each instrument.

VELOCITY AND ACCENTS
One of the appealing aspects of human drum-
ming is accents, and one of the tedious aspects of
electronic drumming is the general (or often total)

lack of them. The usual way a drummer accents a
note is by hitting that note harder than the rest,
which adds emphasis and dynamic to a particular
section of music. Most DJs and electronic music

Hydrogen—the Home Musician’s Free Drum Machine, Part II
We wrap up our two-part drum machine article, grinding into the advanced capabilities of Hydrogen. JOHN KNIGHT
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composers do poorly in this regard and generally
never use them, which gives electronic drumming
a stigma and a very bland sound. However,
Hydrogen allows you to place accents wherever
you want, on any instrument.

Let’s demonstrate this with a basic hand-percus-
sion-style beat. For this demonstration, we use the
Hi-Tom, but feel free to use/add something like a
bongo drum instead (see the Drumkit section).

1. Make a new song, and in the Pattern Editor,
change the resolution to 8T (eighth-note
triplets), and make sure the size is set to 8.

2. Right-click on Tom-Hi, and choose Fill notes.
Now click Play, and you’ll hear a monotonous
passage of single tom-tom notes. Now, we
need to add accents.

3. Accent beats 1, 3 and 4 by clicking near the
top of the line in the velocity section at the bot-
tom of the Pattern Editor (Figure 1). You may
hear a slight difference on the accented notes,
but it’s really not enough, so....

4. Drop the velocity of the normal notes a few
notches to emphasize the accented notes (also
shown in Figure 1).

Now, the effect of the accents should be quite
apparent, and you can (and should) play around
with where you position them, the velocity of
other notes and on which instruments you use
them. If you try to apply accents to a normal
drumbeat using several instruments at once, be
aware that changing the velocity affects each
instrument in isolation, and not all of the instru-
ments on the same beat. To apply accents to

other instruments, simply click on the instrument
name on the left first, and you’ll be good to go.

ACOUSTICS
You also can alter the acoustics of each instrument
with the Instrument Editor. To open the Instrument
Editor, simply double-click on an instrument’s name
in the mixer. This brings up a window with a num-
ber of knobs that all tweak particular acoustic quali-
ties of an instrument. I’ll leave you to experiment
with them, but remember that the best way to test
them is to set up a steady pattern of notes from the
instrument in the pattern editor, and then tweak the
sound as it’s playing. Of particular note are Attack
and Sustain, which make a fairly apparent change
to the sound, but all the effects are worth exploring.

LADSPA FX
With the new LADSPA effects system, you can
modify the sounds of the instruments by using
any of a large number of sound filters. Have you

been wondering what those four little knobs
above each instrument’s volume slider do? These
are assigned to a particular effect, and each knob
controls how much of the effect is applied. But
before we can do that, we need to search
through the available effects and utilise them.

First, change to the mixer window and click on
the FX button in the bottom right-hand corner. A
new section appears with four fields saying, “No
plugin”. For the sake of simplicity, let’s use the first
one for this example. Click on the Edit button, and
in the new window, click Select FX. A new win-
dow pops up, with a list of effect categories on
the left; each subcategory will appear on the right
when you click on a category. (Note, if you have
no choices available, you probably don’t have any
LADSPA effects installed, see the LADSPA sidebar).
Choose an effect that sounds interesting, click OK,
and we’ll apply it to an instrument.

Now, a new window should open with the
properties of the applied effect. Each of these slid-
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ers controls various acoustic aspects of the effect
and can be changed on the fly. Clicking Select FX
lets you choose another, and clicking Deactivate
turns the effect off. In order to use it, change to
the mixer and choose the instrument on which
you want to try it (I like the closed hi-hats for
most testing, but feel free to use anything).

First, click the Play button at the top if the
instrument’s section in the mixer to hear it
unmodified. Next, of the four little knobs, turn the
top-left one all the way around, and now play the
sample. There should be a noticeable difference in
sound, but it’s probably not a pleasant one. Turn
the wheel back until you reach a level you’re
happy with, and then try the new-sounding
instrument in a beat. As you can hear, the new
effects add a whole new life to the mix.

If you go back to the mixer, all of the top-left

knobs on all instruments have the first effect applied
to them. Feel free to apply it wherever you like. If
you follow the previous steps, you can apply effects
to the other three knobs too. Also worth mention-
ing is the Return knob and BYP, or bypass. These are
located in the FX section in the mixer, and if the FX
section is gone, simply click on it again in the bot-
tom-right corner. The Return knob changes how
long the effect is sustained before cutting out, and
it can be particularly useful if an effect sounds over
the top or not obvious enough. The bypass button,
or BYP, simply disables the effect temporarily.

DRUMKITS
Don’t feel that you have to be stuck with the
same drumkit sound that you are given by default,
as you can change to another drumkit by clicking
on View→Show drumkit manager. Here you can

load a new kit, save your own and import/export
new drumkits. For more drumkits, you have to
visit the drumkit section on the Hydrogen page at
http://www.hydrogen-music.org/?p=drumkits.
Once downloaded, simply click the Import tab in
the Drumkit manager, browse for the new file and
click the Import button. Change over to the Load
tab, click on the new kit and click Load.

I rather like the YamahaVintageKit, which
although it has a lot less instruments than the
default, is sampled from a real-life drumkit and
sounds a lot more realistic. For a full-on kit with
toms, chinas and a good open hi-hat sound, try
the Roland TR-626.

MAKING YOUR OWN DRUMKIT
If you have your own drumkit, or at least one you
can record some samples of, you can create your

HOME PLATE
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Instant Life with Stereo-Ed Up Drumkit�

INSTRUMENT POSITIONING

An instant way to add life to the kit is to give
each instrument a position in a sonic landscape
using the balance controls. Simply send each
drum and cymbal somewhere left or right in
terms of where they would sit on a real kit, and
keep the snare and kick in the middle.
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own kit to use in Hydrogen. First, you need to
record your drums. How you do that is up to you,
but I simply used one mic at a time with a single
instrument. I used Audacity and recorded a .wav
file that was several minutes long with me hitting
each drum or cymbal a few times and varying each
note a little with different styles. With each note,
allow enough time for it to die off, or you won’t
be able to isolate it when you’re editing later.

At the end of this process, you then can choose
the notes that sound the best and turn them into
individual instruments with their own .wav files. It’s
also important to chop off any space before or
after the note in each .wav file, or else it will be out
of time. Once you’re happy with the .wav, make
sure it’s set at 44.1KHz, or it’ll play at a strange
speed. These tips aside, there are endless ways to
record drums, and how to do so is up to you.

At the time of this writing, putting together the
new kit was not an elegant process. This will be
addressed in later versions, and as this is unfinished
software, it is excusable. For now, the easiest way
to make your own instruments is to edit a current
instrument and rename it. Here are the steps:

1. Double-click the name of the instrument in the
mixer to bring up the instrument editor.

2. Change to the Layers tab in the instrument edi-
tor, click on Load Layer, choose your new sam-
ple and click Open.

3. Change back to the Instrument tab, and click
on the large print instrument name. This
brings up a dialog to rename it, so choose
your name and click OK. Your new instrument

is ready to use, but first....

4. Move the instrument up or down using the arrow
buttons toward the top-left corner of the pattern
editor so it sits nicely in the list (plus the name
won’t change until you do this). Repeat the same
steps for each instrument. If there are instruments
you want to remove, simply delete the layer and
rename them to an unused number.

5. Open the drumkit manager, and change to the
Save tab. Give your drumkit a name, and enter
a little about yourself and the kit in the given
fields. Click Save.

6. Change to the Export tab, and click Browse to
choose where you want to place your kit.

7. Choose your kit from the drop-down list 
and click on Export.

You now have a kit to share with the
world! Ultimately, making a new kit gives
something back to the community, and
other musicians can benefit from your
work. It doesn’t have to be only drums
either—why not something original and
weird, like an entire percussion section
made up of bin-lids or old furniture?

I hope you’ve enjoyed this series, and I look
forward to seeing what music you create.�

John Knight is a 21-year-old, rock-
climbing, Japan-loving megaloma-
niac, trying to take over the world
from his bedroom via his key-
board. He spends most of his
time tinkering with MPlayer and
headbanging to his MP3s.

HOME PLATE

22www.tuxmagazine.com

The Large Range of
Effects Available
with LADSPA

�

LADSPA FX

LADSPA (Linux Audio
Developer’s Simple Plugin
API) provides a bundle of
audio plugins that can be
used with a large number
of applications—anything
LADSPA-friendly. If you
don’t have any LADSPA
plugins installed, visit
the home page at
http://www.ladspa.org.
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Starting with the Exercise Log data-
base that we created together in last
month’s issue, let’s go ahead and fin-
ish our application. I’m sure that
your Exercise Log database is filling
up, and you’re anxious to print out
your log so you can brag to all of
your friends. With the Base Report
Wizard, you’ll be rubbing your
friends’ noses in your exercise
progress faster than a new Google
rumor spreads through the Internet.
Click on the Reports database
object, and select the Use Wizard To
Create Report task. The wizard will
guide us through the process of cre-
ating a new report.

Six steps are involved in creating
a new report. In general, the steps
involve selecting the data required
for the report, identifying labels,
selecting the grouping options, the
sort options, the layout and creating
the report. Once the report wizard
starts, you first must choose the
source of the data for the report and
the order of the data on the report.

Because our database has only one
table, it is selected immediately. If
you have more options—for exam-
ple, if we had created a Query data-
base object to select a specific
month of data—use the Tables or
Queries list box. Selecting a table or
query populates the Available fields
list box. As with all of the other wiz-
ards, use the >> or > buttons to add
all or specific fields to the report. To
remove all or specific fields, use the
<< or < buttons, respectively. When
complete, the first step of the Report
Wizard should resemble Figure 1.

For our new exercise log report, I
selected all of the fields by clicking
the >> button. I then removed the
LogID field and Notes fields by click-
ing on the field and then clicking the
< button. I decided to rearrange the
order of the first few fields to coin-
cide with PersonID, WorkoutDate and
TimeExercised by using the up and
down arrows found on the side of
the Fields in Report list. Click on the
Next button to advance to step two.

The second step allows us to modify
the labels associated with our data. By
default, the labels are the field names.
Because field names cannot have
spaces, you might find some labels
given as WorkoutDate and
ExerciseType. This step displays two
columns of information. The first col-

umn on the left contains the actual
field names. The second column on the
right contains the label. Edit each label
to your preference. I simply added a
space between words for all of the
field names and added the word rate
after the fields MaximumPulse and
RestingPulse, as shown in Figure 2. 

OpenOffice.org Writer, Does More
Than Just Word Processing
In the second part of this article about the new OpenOffice.org Base component, we finish the application
we started in the previous issue, plus we complete a simple mail merge, using the new Mail Merge Wizard.
KEVIN SHOCKEY
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I also removed ID from PersonID. Click
Next to go to step three.

The grouping step of the Report
Wizard allows us to group the data
together to improve readability. This
is desirable, because it lets us simpli-
fy the report. For example, if you
and a friend have both started a
new exercise routine, you might
want to track both of your progress.
So, while adding data, you would
choose Person identification 0 for
you and 1 for them. If you were to
print out the data without grouping,
the other person’s data would be
mixed in with yours, making it more
difficult to read, follow progress and
so forth. By grouping the data, you
can specify that the data is grouped

by Person, meaning that all of your
data appears together with your
friend’s data grouped separately. To
implement this grouping for our
report, click the PersonID field, and
then click the > button. This moves
the PersonID field over to the
Groupings list, as shown in Figure 3.
Click Next to go to step four.

To give an added touch of read-
ability, let’s add an additional sort
order to our report. Recall that in
order to group the data by PersonID,
Base must first sort by PersonID. This
is reflected when you see the fourth
step of the Report Wizard. The Sort
by selection already has PersonID,
which was the grouping we selected
in the previous step. To prevent
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Figure 2. Modifying Data Field Labels Figure 3. Adding a Grouping Level

Figure 4. Sort Option for Additional Sorting
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potential errors, the wizard disables
the Sort by selection option, so the
first option enabled is the Then by
option. Select the WorkoutDate,
which will sort within each PersonID
group by the date of the exercise.
Figure 4 illustrates this selection.
Click Next to proceed to step five.

Just as with the Form Wizard, as
we make selections in the Report
Wizard, the wizard is constructing the
report in OpenOffice.org Writer
behind the dialog. Note that it is using
dummy text to create the report. The
wizard will replace this text when the
report is complete. The fifth step is
focused on the look of the report.
With this step, we choose the layout
of the data and the layout of the

headers and footers. There are three
basic layouts: Align Left, where the
fields are laid out in a tabular fashion
with all data aligned left; Outline,
where any data fields that group the
report are listed once and then not
repeated on each row; Outline and
indented, similar to the outline layout
but also indented from the left edge
of the report. The layout of the head-
ers and footers contains 11 options
that assign a header, footer and page
background. For our exercise log
report, I selected the Outline - Red
and Blue layout with the Generic lay-
out of the headers and footers. These
choices are shown in Figure 5. I stayed
with the default Landscape orienta-
tion, but if necessary, you also can

choose Portrait from this step. Click
Next to go to the last step.

Other than choosing a name and
deciding what to do after finishing
the wizard, a potentially confusing
option on the last step is what kind
of report you want to create. A static
report document saves the output of
the Report Wizard at the time the
Report Wizard is finished. The other
option is a dynamic report template.
A dynamic report creates a report
database object that you can re-use.
It also creates an entry in the Links
heading in the data source explorer.
This is a confusing way of making you
choose between a one-time only
report with the current data, or a re-

usable report that you can print any
time you want. I imagine that for
most cases, a dynamic report provides
a little more flexibility. However, edit-
ing a dynamic report template is way
beyond a new user’s interest or ability.
Although both the Form and Report
functionality use the OpenOffice.org
Writer component, modifying a form
design is significantly easier to do
than modifying a dynamic report tem-
plate. To finish our exercise report, I
used the default name suggested,
which was based on the data source.
I chose the dynamic report and decid-
ed to create the report immediately.
Figure 6 illustrates the final report.

With this step, we complete our
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database application. We created a
new database, a new table, a form for
data entry and a report to print out
our data. We did this using mostly
wizards, but taken together Base still
provides a very powerful little system.

COMPLETING A DATA MERGE USING
THE MAIL MERGE WIZARD
One of the most popular tasks peo-
ple use both a database and a word
processing application for is a mail
merge. Originally, this referred to the
specific task of merging data with a
template to mail a stock letter to a
group of addresses. Now, this gener-
ic term applies to any task of merg-
ing data with a template. Any
decent office-supply store will carry a
wide range of paper products that,
combined with the pre-formatted
templates available within
OpenOffice.org, provides great
power to any user. From shipping
labels to business cards or name
tags, this combination of tools can
provide highly professional results
with a little bit of effort.

Recently, a project of this nature
fell into my lap. I had to take a
spreadsheet of contact information
and a couple boxes of name tags
and produce a bunch of name tags
for a group of people registered for
an activity. When I started working
on this task, I immediately thought
of the new Mail Merge Wizard in
OpenOffice.org 2.0 to solve my
problem. OpenOffice.org solved my

problem in three steps. First, I had to
create a database to connect to the
spreadsheet containing the contact
information. Second, I needed to
create a label template that would
lay out my merge fields and format
the template. The final step was run-
ning the Mail Merge Wizard.

In order to use the spreadsheet
information, you first have to 
create a new database. From any
OpenOffice.org component, select
File→New→Database. You should see
the Database Wizard start. I described
how to use the wizard in the previous
issue; this time, we will connect to
an existing database. Click on the
Connect to an existing database
option, and the list box will enable,
allowing you to select the database
type. Select the Spreadsheet option,
as illustrated in Figure 7, and click on
the Next button.

We next need to set up a connec-
tion to the spreadsheet. If you know
the fully qualified path and filename,
enter them in the Location and file-
name fields; otherwise, click on the
Browse button and locate the
spreadsheet file. After the file is
found, and the name and location
appear in the wizard as illustrated in
Figure 8, click on the Next button.
Make sure you register the database
with OpenOffice.org in the last
screen of the Database Wizard, and
click the Finish button. The wizard
finishes creating the database, saves
the database and then opens the
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database for editing. You can close
the database file as soon as it opens.

Now, in the second step, we need
to create a template for the data
merge. We use OpenOffice.org’s
built-in definition of labels to create
a specific layout to match my name
tag dimensions. From any
OpenOffice.org component, select
File→New→Labels. You should see a
new window appear—the Labels
window. The initial tab displayed is
the Options tab; click on the Labels

tab. The Labels tab lets you build the
inscription and set the format for the
new labels. The inscription is the text
you want to display on each label.
For our example, we will pull this
text from the spreadsheet. To add
field information from a database,
first select the database from the list
of registered databases available in
the Database list. In my name tag
project, I selected the name of the
database created in the previous
step. Immediately, the Label Wizard

populates the Table list with all
tables defined in the database. In my
example there was only one table, so
it becomes the only option available.
Select the table from the list. Once
again, the Label Wizard automatical-
ly retrieves the column names from
the table and displays them in the
Database Field list.

In general, the process of
adding database fields to the
inscription involves locating the
required field and clicking on the
field. Right next to the Database
Field is a button with a left-facing
arrow. This button moves the
database field into the Label Text
field. In my example, I located the
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Figure 9. Completing the Label Wizard

Figure 10. Finished Label Template Document
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Name field and clicked on it. Then,
I added the field to my label text
by clicking on the left-arrow button.
I clicked into the label text after the
<NameTagMerge.Sheet1.0.Name>
entry and pressed Enter. This moved
the cursor to the next line, ready to
receive the second field. I repeated
the database field add process using
the Company field. The label text
then resembled Figure 9.

With the inscription complete, we
next need to finish the formatting
for the labels. There are three main
options in this section. First, you can
choose whether the labels are one

continuous sheet or separated indi-
vidually, specify the brand of the
labels and the specific type of labels.
The name tags I was given corre-
sponded to separate sheets, the
Brand was Avery Letter Size and the
specific type was the Name Tag Kit. I
made those selections and then
clicked on New Document. At this
point, the Label Wizard created the
label template and opened the tem-
plate. The template consists of one
page of labels with placeholders for
the database fields. Figure 10 illus-
trates this new document. At this
point, you are free to format the

template as desired. A couple of
quick changes to consider are cen-
tering the database fields and
increasing the font size. You also can
insert a picture into each table cell to
give the labels some color or charac-
ter. Save the file and close.

In the final step, we generate the
merged document using the tem-
plate and the database. From any
OpenOffice.org component, select
Tools→Mail Merge Wizard.
Although the wizard contains
eight steps,
because we
already have
our template
complete,
most of the
steps are
skipped. In
the first step,
we need to
select the
Start from
existing docu-
ment and
then select
our template.
Click the
existing docu-
ment option,
then click the
Browse but-
ton (Figure
11). When the

open window appears, locate our
document and click Open. When
you return to the wizard, click on
the Next button. The next three
steps don’t really apply to our
example, so skip steps two, three,
and four by clicking the Next but-
ton three times. As we are not
going to modify the salutation,
the wizard also should skip auto-
matically step five.

You should be on step six of the
Mail Merge Wizard. If you are ready
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to complete the merge process, click the
Next button. This starts the process to
create the merged document. As shown
in Figure 12, you should see the wizard
process all of the records contained in
your table. Now, your merged document
is ready. If you like, you can personalize
this document, but for the purposes of
our example, it is not necessary. Click the
Next button to advance to the last step
of the wizard.

Because our merge is already complete,
we can take advantage of this and save the
merged document. First, select the Save
merged document option, and then select
the Save as single document (Figure 13).
Click on the Save Documents button, and
the wizard saves the document and finishes.

Although it didn’t use much of the
Mail Merge functionality, this simple
example provides a brief glimpse of the
potential of the new wizard. When you
combine this new wizard with the ability
to create a database that connects to
common contact resources, such as
Evolution and Groupwise, the power
available from the new OpenOffice.org
becomes even more impressive.

CONCLUSION
To be honest, for me, the new database
reports, database source browser and the
database merge functionality seem imma-
ture—almost as if they were not quite fin-
ished. There are some funny little quirks with
the reports, such as always having the first
page blank when grouping by a data field
and the relatively sparse ability to modify a
report template easily, to name a few exam-
ples. In addition, now that we have walked
through a sample mail merge, did it occur to
you that the mail merge should be more
tightly coupled with the report functionality?
If I define a new database connection, why

do I have to complete two separate functions
to merge my data? Shouldn’t I be able to
integrate the ability to create a merge tem-
plate from within the report functionality?

In defense of OpenOffice.org, I may not
be using the new data merge functionality
as originally designed. However, after several
frustrating hours trying to follow the
OpenOffice.org Help while under pressure
to get my name tags printed, I was satisfied
simply to get the mail merge working. I
imagine as more users pound on these
new features and collaborate with the
OpenOffice.org developers, the usability
of OpenOffice.org will only get better.�
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Figure 13. Save Document Step

Kevin Shockey is Editor
in Chief of TUX.

Figure 12. Creating the Merged Document
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I’m sure KDE’s ability to be customized almost infinitely is the reason I don’t
yet rule the world. If I could only take the time and energy that goes into
hunting for the cutest wallpapers, downloading icon themes, installing
mouse cursor sets—and channel it into study or work—I’m quite certain I’d
be a star pupil or model employee. As it is, many days when I should be
doing something more productive, I find myself time and time again visiting
that themer’s treasure trove, KDE-Look.org (http://www.kde-look.org).

The KDE Control Center puts a dazzling array of configuration options in
one convenient location. In the Appearance & Themes section are the mod-
ules controlling all aspects of the look and feel of your KDE desktop. Here
you can install and configure wallpapers, icon themes, color schemes and
much more. KDE-Look.org provides a place for users to share the customiza-
tions they have made.

WALLPAPERS
With KDE 3.4 came Get Hot New Stuff, a simple way of downloading user-
contributed data for applications. In addition to the selection of artwork that
comes with a KDE installation, KDesktop makes use of this new technology to
streamline searching for and installing new desktop wallpapers from KDE-
Look.org. Open the KDesktop configuration dialog by right-clicking on the
desktop and selecting Configure Desktop... from the context menu. The dialog
that appears shows your current desktop background settings. Beneath the
picture of the computer monitor on the right, click on Get New Wallpapers.

In the Get New Wallpapers dialog, click on any image thumbnail to see
more detailed information for that image. Once you’ve found an image you
want to download, simply click Install. The image is downloaded and
installed. After exiting the Get New Wallpapers dialog, you can set your new
image as the desktop background by selecting it from the Picture drop-down
box in the KDesktop configuration dialog, under Background. If you already
have an image saved to your hard disk that you’d like to set as the desktop

wallpaper, that’s even easier. Simply navigate to where you’ve stored the
image in Konqueror and drag and drop the image to the desktop. In the
context menu that appears, select Set As Wallpaper.

ICON THEMES
Icon themes are a popular and striking way of changing the look of your
KDE desktop. Download icon themes from the Icons section of KDE-
Look.org. To install an icon theme you’ve downloaded, fire up the KDE
Control Center. Under Appearance & Themes, select Icons. Click on Install
new theme at the bottom of the dialog, and either navigate to the location

Customizing KDE with KDE-Look.org
With the help of KDE-Look.org, Jes Hall reveals her productivity secrets and explains how to add a little “tszujing” to KDE.

JES HALL
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where you downloaded the icon theme by clicking
on the small folder icon to the right of the text
field, or drag and drop the icon theme archive
into the text field from a Konqueror window. Click
OK, and KControl installs your theme. This step
sometimes can take as much as half a minute, as
a large number of small icon files are being
extracted and copied to a new location. Once fin-
ished, you can load your new icon theme by high-
lighting its name in the list of installed themes
and clicking Apply. Keep in mind that not all files
listed on the KDE-Look.org icons section are com-
plete themes able to be installed in this way.
Carefully read the entry’s description and any user
comments to help distinguish which are complete
themes and which not. Once you’ve installed the
icon theme, you’re free to delete the theme
archive you downloaded.

COLOR SCHEMES
KDE comes with a wide variety of color schemes,
and the colors section available at KControl→
Appearance & Themes allows you to select a
scheme, modify existing schemes and install new
schemes. To install a scheme you’ve downloaded
from KDE-Look.org, click Import scheme. Navigate
to where you have downloaded the scheme file or
the archive containing it, and click OK. Your new
color scheme is now selectable in the list of installed
schemes. Once you’ve installed a color scheme, you
can delete the color scheme file or archive you
downloaded. You also can create your own person-
alized schemes by highlighting a scheme you’d like
to modify and customizing the color values for vari-
ous interface elements in the Widget Color drop-
down box to the right.

Hint: the color preview image at the top of the
dialog is clickable. To change the title bar color,
you can click on the title bar in the preview image
and then on the small color swatch underneath
the Widget Color drop-down box that represents
its current color value. This brings up the color
chooser dialog where you can select a new color
for this widget.

MOUSE CURSORS
There is a wide range of X11 mouse cursor
themes available for download on KDE-Look.org,
and KControl provides a nice interface for
installing and applying mouse cursor themes,
although it’s pretty well hidden. To install a cursor
theme you’ve downloaded, open KControl and go
to Peripherals→Mouse. (Oh sure, I hear you say,
that’s just so logical.) The second tab—cursor
theme—is where we manage our mouse cursor
themes. Click Install new theme, and navigate to
where you downloaded the mouse cursor theme

archive. Once you’ve selected it, click OK. Select
your new theme from the list of installed themes,
and click apply. You’ll need to restart KDE before
these changes take effect. Once you’ve installed
the mouse cursor theme, you can delete the
archive you downloaded.

SPLASH SCREENS
A splash screen is the progress meter that appears
when you log in to or start KDE. Generally, each
distribution brands its KDE packages with its own
artwork as the splash screen. To install a new one,
once you’ve selected a splash screen you like from
KDE-Look.org and downloaded it to disk, launch
KControl and go to Appearance &
Themes→Splash Screen. Click the Add button,
and navigate to where you’ve downloaded the
splash screen archive. Once you’ve selected the
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Figure 2. The Icons Dialog Figure 3. The Colors Dialog
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archive file, click OK. Your new splash screen
should appear in the list of available splash
screens. To see what it will look like without hav-
ing to restart KDE, click Test. Once you’ve finished
installing the splash screen, you can delete the
archive you downloaded.

THEMES
Once you have your KDE desktop looking exactly
how you like it, you can save the settings as a
coherent theme in KControl→Appearance &
Themes→Theme Manager. This lets you save
groups of favorite settings and switch between
them quickly and easily.

With KDE, your imagination is your only limit.
Once you’ve created your masterpiece, you can
share screenshots and discuss all aspects of
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Figure 4. The Splash Screen Dialog

Figure 5. Share screenshots on KDE-Look.org to show off your customizations.

WHERE DOES KDE PUT MY THEMES ONCE I’VE INSTALLED THEM?

� Icon themes: ~/.kde/share/icons
� Color schemes: ~/.kde/share/apps/kdisplay/color-schemes
� Splash screens: ~/.kde/share/apps/ksplash/Themes
� Mouse cursors: ~/.icons
� Wallpapers: ~/.kde/share/wallpapers

Jes Hall is a UNIX sys-
tems consultant and
KDE developer from
New Zealand. She’s
passionate about help-
ing open-source soft-
ware bring life-chang-
ing information and
tools to those who
would otherwise not
have them.

KDE’s customization with other KDE themers by creating a free account on
KDE-Look.org. You’ll all have to excuse me now—I need to go make sure this
article is handed in on time, or Kevin will know what to blame!�
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The GNOME desktop (http://www.gnome.org) is,
in a way, KDE’s obnoxious over-achieving younger
brother. Though this desktop environment hasn’t
been around for as long as KDE has, it’s reached
the same level of stability and has its own strong
base of fans. For those more familiar with other
operating systems or KDE, GNOME’s top and bot-
tom panel setup might take some getting used to.
However, this setup is a great way to take advan-
tage of available space with lots of panel icons.
Figure 1 shows the reference release of GNOME
2.12, a live CD people can download to see what
the very latest version looks like, without having
to install anything (you can get it by going to
http://www.gnome.org/start/2.12).

A TOUR OF CONFIGURATION OPTIONS
For those who enjoy tweaking their GUI, the
menu of most interest is the farthest to the right,
and is named either System or Desktop, depend-
ing on which version of GNOME your distribution
uses. (Through the rest of this article, I refer to the
System menu; substitute Desktop if needed in its
place.) By going to System→Preferences, you
can find all of the user-level configuration
options. System→Administration contains those
available for administrators. Table 1 shows what
you will find in each of these menu options, as I
don’t have the space to go through all of them
thoroughly. The options listed correspond

directly to those available on the GNOME 2.12
live CD. Your distribution may have a slightly

different layout and may offer different GUI
configuration options.

Customizing GNOME
Dee-Ann LeBlanc explains how to tweak the GNOME desktop with the assistance of GNOME Art.

DEE-ANN LEBLANC

Figure 1. The reference version of GNOME 2.12—your distribution’s version of GNOME will look slightly different.

http://www.gnome.org
http://www.gnome.org/start/2.12
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Table 1. GNOME Configuration Menu Options

Location Purpose

System→Preferences→

About Me Enter e-mail, phone, IM, Web and physical contact information. Also allows you to change your password.

Assistive Technology Support Enable GNOME features designed for those with limited mobility or sight.

Desktop Background Alter your desktop’s current background. Also accessible by right-clicking the desktop and choosing Change Desktop Background from the context menu.

File Management Specify how Nautilus (the GNOME file manager) presents files to you and how you interact with them.

Font Change the fonts, sizes and font properties for applications, your desktop, your window title bars and in command-line terminals.

Keyboard Change your keyboard’s responsiveness, layout, accessibility features for those with limited mobility, and even to enforce typing breaks on a regular basis.

Keyboard Shortcuts Assign what will happen when you press certain keys or key combinations.

Login Photo Set a user avatar for use in the login screen. Available in some versions of GNOME 2.12—if you don’t have this menu option, see System→Preferences→About Me,
and click the image in the upper-left corner of the resulting window.

Menus & Toolbars Set how the menus in your GUI will behave. This is not the same as changing menu content.

Mouse Configure your mouse’s behavior, responsiveness and which hand can use it.

Multimedia Systems Selector Tell the system what engines it should use for sound and video. May be located in a More Preferences submenu.

Network Proxy Set up what proxies to use for those whose system administrators do not allow them direct access to the Internet.

PalmOS Devices Configure your system’s interaction with devices using PalmOS. May be located in a More Preferences submenu.

Preferred Applications Tell your system which Web browser, e-mail client and terminal program to open by default. May be located in a More Preferences submenu.

Remote Desktop Configure whether the ability to view and use your desktop remotely is allowed, and how secure it should be.

Removable Drives and Media Define how various multimedia issues are handled, such as whether CDs are automatically loaded by the operating system when you place them in the drive.

Screen Resolution Alter your screen resolution and refresh rate.

Screensaver Configure which screensaver to use, if any, and its behavior.

Sessions Configure the GUI’s behavior when you log in and out, including which programs to start automatically, if any.

Sound Configure what kind of sounds are used by your system, and when.

Theme Select and edit your desktop theme.

Windows Set how your windows react when interacted with.

System→Administration→

Login Screen Setup Define how your GUI login screen behaves. Available only in some distributions.
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CONFIGURING YOUR BACKGROUND
A popular facet of the desktop that people
often want to customize is the desktop 
background. As you see in Table 1, selecting
System→Preferences→Desktop Background, 
or right-clicking the desktop and choosing
Change Desktop Background from the context
menu, opens the Desktop Background
Preferences dialog (Figure 2).

In the upper list box, select either No
Wallpaper, if you want only color(s) in the back-
ground, or scroll through the list to find a wall-
paper you like. For those who want to use wall-
paper, if you have an image you want to use
that isn’t in the list, you can add it. Click the
Add Wallpaper button to open the Add
Wallpaper dialog, browse to the image’s loca-
tion, select the image you want to use, and
then click the Open button. Once you have your
wallpaper selected, the Style button lets you
choose whether you want the wallpaper to
stretch if necessary to take up the whole screen
(Fill Screen), to be centered at its original size
and then surrounded by a desktop color of your
choice (Centered), to be stretched until it hits
either the top and bottom or right and left
edges of the screen and no more (Scaled) or to
be repeated at its original size (Tiled).

If you chose No Wallpaper or have bare
desktop showing, you might want to change
the colors. First, go to the Desktop Colors but-
ton and decide whether you want the screen to
be one color (Solid Color) or a shifting of one
color into another (Horizontal Gradient for a
gradient across the screen or Vertical Gradient
for a top-to-bottom gradient).

Depending on your choice, you will have either
one (solid) or two (gradient) color buttons. When
you click one of these buttons, the Pick A Color
dialog appears (Figure 3). If you know how to use
the text boxes to enter the color, do so.
Otherwise, start your selection by clicking on the
wheel around the triangle and dragging until the
color you want is included within the triangle.
Now, click and drag inside the triangle until the
color you want is displayed in the right-hand por-
tion of the box below. Those who have an image
open containing a color they want to use can
instead click the eyedropper icon and then click

and drag on the image until the desired color
appears in the box’s right side.

GETTING FANCIER
If you want to get fancy, go to http://art.gnome.org.
Here you will find backgrounds, a variety of
themes and more. The Tutorials section is 
slowly being filled out, the FAQ answers many
questions you may have, and the Forums 
section provides people you can talk to if 
you need help. Other cool sites are 
GNOME-Look.org (http://www.gnome-look.org)
and http://themes.freshmeat.net.�

Dee-Ann LeBlanc (dee-ann.blog-city.com)
is an award-winning technical writer
and journalist specializing in Linux and
miniature huskies. She welcomes com-
ments sent to dee@renaissoft.com.
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Figure 2. The GNOME Desktop Background
Preferences dialog.

Figure 3. When your color properly appears, click
OK, and proceed to the second color box if you
have one.

http://art.gnome.org
http://www.gnome-look.org
http://themes.freshmeat.net
mailto:dee@renaissoft.com
http://dee-ann.blog-city.com
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Firefox is arguably the best browser out there; however, default Firefox is
kind of plain. It does not have to be though. Firefox is extensible and theme-
able, both of which are fancy ways of saying 1) you can install extensions
that add new features to Firefox, and 2) you can install themes that change
the way Firefox looks.

I’m sure you’ve seen those shows where people take a piece-of-junk
car and in five commercial breaks and 60 minutes turn it into a work of
art. Well, you can do the same to Firefox, but it won’t cost you your
child’s inheritance to do it, and it will take less time—you can even do it
during the commercial breaks.

Firefox is everywhere these days. It is included with virtually all Linux dis-
tributions, and packages for it are readily available from http://mozilla.com
and your Linux distribution’s software package repository. You probably used
Firefox to download this issue of TUX that you are reading right now.

One thing to warn you about though is that some of the extensions and
themes I’m going to be talking about won’t work with anything less than
Firefox version 1.5. Most mainstream Linux distributions are on a yearly or
twice yearly release schedule, and so they may not have the most current
version. To check which version you have, go to the Firefox Help menu and
choose About Mozilla Firefox.

If you find you are using a version less than 1.5, go to
http://mozilla.com and click on the big Download Firefox button. This
downloads a file called firefox-1.5.0.1.tar.gz or something similar. Open
the file in your archive manager, usually simply by clicking or double-click-
ing it, and drag the firefox folder to your desktop. Open the firefox folder,
and look for a file called firefox. Run this script, again simply by clicking
or double-clicking on it, and you will be running the latest version.

Firefox comes standard as a capable, user-friendly browser. But, it can be
so much more! I mean, yes, capable and friendly are good and all, but what
about exciting or fun? The first stop we need to make is at the Extensions

Manager. Go to the
Firefox Tools menu, and
click on Extensions.

Extensions are little
bits of computer code
that extend or change
the way a program
works. Think of them
as under-the-hood
improvements. The
default install for
Firefox 1.5 includes
two extensions:
Talkback, which gives
Firefox the ability to
send crash reports to
the Firefox developers
at Mozilla.org, and
DOM Inspector, which
is probably very useful
to those who under-
stand what it does. I
ignore both of them. We definitely need to add some more exciting
extensions here. Click on the Get More Extensions link in the lower-right
corner of the Extensions Manager window to go to the Firefox exten-
sions Web site.

With more than 1,000 extensions from which to choose, it may seem hard to
distinguish the good (https://addons.mozilla.org/extensions/moreinfo.php?id=398)
from the hilarious (https://addons.mozilla.org/extensions/moreinfo.php?id=507)
from the stupid (https://addons.mozilla.org/extensions/moreinfo.php?id=451).

Pimping the Fox
An introduction to customizing Firefox with Extensions and Themes.

DANIEL BARTHOLOMEW

Figure 1. Before: Firefox, Fresh from the Factory

Figure 2. The Firefox Extensions Window, Almost
Empty

http://mozilla.com
http://mozilla.com
https://addons.mozilla.org/extensions/moreinfo.php?id=398
https://addons.mozilla.org/extensions/moreinfo.php?id=507
https://addons.mozilla.org/extensions/moreinfo.php?id=451
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Okay, so my distinction between what is hilarious and what is stupid is
questionable, but let’s just say that there are a lot of “interesting”
extensions out there. You’ll find the best by clicking on the Popular and
Top Rated links in the left sidebar of the Extensions site.

For our first extension, let’s install FlashGot (https://addons.mozilla.org/
extensions/moreinfo.php?id=220), a very popular and useful extension
for downloading single or multiple files from a Web page in one click.

From the FlashGot page, click on the Install Now link to bring up 
an installation window. You might have to wait for a little countdown
timer to finish. When it
does, click the Install
Now button to install
the extension.

Take another look
at the Extensions 
window, and you’ll
see that FlashGot will
be installed when
Firefox is restarted.

This insistence on
restarting is the most
annoying part of

installing extensions and themes. I hope in the
future, developers will figure out a way to
avoid restarts. Until then, they are a way of life
when installing Firefox add-ons. Restart Firefox,
click on the Tools menu, and you will see a
new FlashGot entry, complete with a nifty
lightning-bolt icon.

Right-click on a link, and you will see that
FlashGot is there too.

We’ve gotten started by customizing our
browser, and FlashGot is certainly nice, but exten-
sions can do so much more. I’ve put together a list
of six of my favorite extensions. These will add sev-
eral useful features to Firefox and turn your boring
browser into a custom-built Web cruiser. My
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Figure 3. Ready to Install the FlashGot Extension

Figure 4. Installing the FlashGot Extension

Figure 5. FlashGot is now installed, or will be,
after we restart Firefox.

Figure 6. The Tools→FlashGot Menu

https://addons.mozilla.org/extensions/moreinfo.php?id=220
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favorites include:

� FlashGot: https://addons.mozilla.org/extensions/moreinfo.php?id=220

� Colorful Tabs:
https://addons.mozilla.org/extensions/moreinfo.php?id=1368

� Forecastfox: https://addons.mozilla.org/extensions/moreinfo.php?id=398

� FoxClocks: https://addons.mozilla.org/extensions/moreinfo.php?id=1117

� FoxyTunes: https://addons.mozilla.org/extensions/moreinfo.php?id=219

� Greasemonkey:
https://addons.mozilla.org/extensions/moreinfo.php?id=748

We’ve already talked a little about FlashGot, so let’s move on to Colorful Tabs.
Colorful Tabs does exactly what it says, it makes your tabs more colorful. Instead
of every tab being the same (boring) gray, each tab will be colored differently.
This improves Firefox’s usability, especially when you have a lot of tabs open.

Forecastfox puts a custom weather forecast into your Firefox status bar, or
whichever toolbar you prefer. After installing the extension and restarting
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Figure 7. The FlashGot Contextual Menu

Figure 8. Colorful Tabs in Action

Figure 9. The Forecastfox Options Window

https://addons.mozilla.org/extensions/moreinfo.php?id=220
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Firefox, it prompts you to enter a location code. You either can put in your
postal code or click Find Code to search by city or country name. You also
can customize how the current conditions are displayed and even choose to
rotate through forecasts and current conditions for several locations. Play
around with it until you find settings to your liking.

FoxClocks is another informational extension, but instead of weather, it
focuses on time. It can display multiple clocks in the status bar, a toolbar or
in the menu bar for any of hundreds of cities around the world. Now you
can know at a glance what time it is for Dad in Dubuque, Marge in
Melbourne and Sid in Singapore.

Have you ever been listening to music while surfing the Web and needed
to switch tracks, or lower the volume or pause the music? Instead of having
to switch to your music player, you can do it all from inside your browser,
thanks to FoxyTunes. This handy extension can control several of the more
popular Linux audio players, including amaroK, Rhythmbox and XMMS. By
clicking on the little arrows, you can choose to display or hide the currently
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Figure 10. Mouse over one of the forecast icons to get a helpful forecast.

Figure 11. Selecting My Preferred Audio Player for FoxyTunes

Figure 12. Ready to Install a Greasemonkey Script
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playing song, or use the controls to pause, play and skip tracks, or
change the volume.

The last extension I want to share is also the most versatile.
Greasemonkey lets you install thousands of scripts that actually change

the Web sites you visit. After installing Greasemonkey, you’ll see a little
monkey head in your status bar. You can left-click on it to enable or 
disable Greasemonkey and right-click on it to bring up a menu with 
a link to the script manager.

To install Greasemonkey scripts, go to http://userscripts.org and locate the
script you want to install. There are scripts of every shape and variety. Some
can remove ads, others can add new features, and some simply speed up
sites. As an example, let’s install a script that makes it easier to view videos

from CNN.com. Navigate to the script description page, and click on the
Install this Script link.

You then will see the script in all of its JavaScript glory. You also
should see a little info bar at the top of the window with an Install 
button. Click it, and you should receive almost instant confirmation 
that the script was installed.

Now when I go to CNN.com and click on a video link, the video opens
directly in my preferred video application instead of in its embedded on-line
player. But, this simple little script is only a beginning; http://userscripts.org
claims to have more than 900,000 scripts available, with more added all the
time. Granted, many of them will not be useful to you, but you are almost
guaranteed that some of them will be. Entire categories are devoted to pop-
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Figure 13. Simply click on the Install button to install the script. Figure 14. The Greasemonkey script is now installed and ready to use.

http://userscripts.org
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ular on-line destinations
like Google, Amazon,
del.icio.us, Flikr and
Gmail. Spend some
time on the site and
experiment with some
of the scripts, and you’ll
soon wonder how you
survived without it.

Now that we have
made some under-the-
hood improvements to
how it operates, let’s
give Firefox a new coat
of paint. Don’t get me
wrong, the default look
is very nice. It’s clean,
uncluttered, functional

and safe. Sometimes I like safe. Sometimes safe is good. But safe can get
boring. This is a browser we’re talking about here, one of the most heavily
used applications out there. It should be fun to use and nice to look at.

Go to the Firefox Tools menu and click on Themes. This opens the Themes
window, which, if you haven’t yet installed a theme, will have only one entry,
the Firefox (default) theme. Yes, the default Firefox paint job is just another
theme. About the only difference between it and other themes, apart from
the way it looks, is that this theme is the only one that can’t be removed.

Click the Get More Themes button to open a window to the Firefox
themes Web site. At the time of this writing, about 150 themes are available
from which to choose, with more being added all the time. They range
from simple to elegant to tacky and everything in between. As is the
case with extensions, you can quickly find a lot of high-quality themes
by utilizing the Popular and Top Rated buttons in the left-hand menu
bar of the Themes Web site.

Installing a theme is much like installing an extension. Let’s try the
BlackJapan (https://addons.mozilla.org/themes/moreinfo.php?id=1390)
theme as an example. From the BlackJapan description page, click the Install
Now link, click OK to the pop-up confirmation dialog, and the theme should
be downloaded and installed automatically. Switch to the Themes window,

and select it, and then click the Use Theme button. Restart Firefox, and revel
in BlackJapan’s dark beauty.

Tastes vary widely, so you may have to experiment with several themes
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Figure 16. Ready to Install the BlackJapan Theme

Figure 17. Installing the BlackJapan Theme

Figure 15. The Firefox Themes Window, Almost
Empty

https://addons.mozilla.org/themes/moreinfo.php?id=1390
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before you find one that fits. However, in the spirit
of pimping Firefox, I suggest the tacky, over-the-top
goodness of Pimpzilla (https://addons.mozilla.org/
themes/moreinfo.php?id=1542). Shag carpeting,
fuzzy dice and lots of bling combine with the
extensions installed earlier to provide a browsing
experience like no other. Check it out.

Now, get out there and make Firefox yours.�

Daniel Bartholomew has been using computers since the
early 1980s when his parents brought home an Apple IIe
(with an 80-column card!). After stints on Mac and Windows
machines, he discovered Linux (Slackware) in 1996 and has
been using various distributions ever since. He lives with his
wife and children in North Carolina.
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Figure 18. The BlackJapan theme is installed. Figure 19. Restart Firefox to use BlackJapan.

Figure 20. The BlackJapan Theme in Action Figure 21. After: Colorful Tabs, FoxClocks, FoxyTunes, Forecastfox and
Greasemonkey Having a Party in Pimpzilla
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Even though it is the first generation of the Nokia
770, I found the Nokia 770 Internet Tablet so easy to
learn that it should receive wide acceptance from the
general public. It is simple to use, expandable and
has the best browsing experience I’ve seen in a
mobile PDA. This browsing experience is enhanced
by the 770’s high-resolution 800x480 touch screen,
capable of displaying 65,536 colors. This device is
made purposefully to appeal to the mobile user, and
it excels in providing an outstanding user experience.

A few years ago, a colleague tried to convince
me that a Palm-based handheld mobile device
could roughly replace a laptop computer. In gen-
eral, I agreed with him, but asserted that it would
be a challenge to pull it off. With the Nokia 770,
the more I played with it, the more I became con-
vinced that this might be such a laptop-replacing
product. For most laptop users, the key features
are e-mail, browsing, blogging, writing and occa-
sionally presenting. With the exception of sending
an external video signal to a computer projector, I
really believe that everything else might be possi-
ble with the Nokia 770. Because the browsing
experience is landscape, it is comparable to a lap-
top (unlike phones or other handhelds); add in an
external wireless Bluetooth keyboard and some
extra Flash memory, and you have a lightweight,
responsive, easy-to-use laptop replacement.

THE BASICS
The Nokia 770 Internet Tablet uses the Internet
Tablet 2005 software, which is a Linux-based
Debian derivative. Out of the box, the base system
provides a wide variety of applications, including
an Opera-based browser with pre-packaged
Macromedia Flash player capabilities. In the
next section, I explain the Nokia 770’s browsing
experience in more detail.

To complete the Internet-based set of tools, the
770 also has an e-mail client, RSS news reader, PDF
viewer and various media players. To use these
tools, you have to connect to the Internet. The
770 provides connectivity through 802.11 b/g and
Bluetooth. However, this is assuming that your
phone provides broadband access and supports
Bluetooth connectivity. The default choice for con-
necting to the Internet, without configuring addi-
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Nokia 770
If you are looking for a convenient, easy-to-use
PDA that’s also Linux-based and open-source
powered, this is the handheld for you.

KEVIN SHOCKEY

Figure 1. Nokia 770
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tional connectivity alternatives, is wireless LAN.
Setting up access for my wireless network was

simple. A wizard steps you through the process. The
770 can scan for wireless connections and displays
the results of the networks found, the strength of
the signal and the security level of the network.

Upon booting, the 770 displays the home
view. The home view is a dashboard of sorts that
provides the ability to display various dialogs,
including Internet radio, Clock, News and a Web
shortcut. As you might expect, the Internet radio
lets you stream an Internet radio station to your
770. It includes basic controls that are simple to
use. If you’re looking to add some different sta-
tions, I’d recommend following along with the
user guide. The process was not intuitive, but it
was possible with help from the user guide. The
clock is, well, a clock. Click on the clock display to
access the clock configuration window.

The News window displays the latest news
posts from the news reader. Of course, you must
add feeds to the news reader before this window
becomes operational. If you’re familiar with tradi-

tional RSS readers, you will be able to get this
going easily. The Web shortcut dialog provides a
nice one-click access to a favorite Web page.
Once enabled, you can configure the Web short-
cut from the home-view menu, Web shortcut
details option. You can use your choice of images
to go along with your favorite Web address.
Figure 2 displays a fully configured home view.

The remainder of the functionality of the 770
is provided by accessing the other application but-
tons. Along the left-hand edge of the screen runs
the task navigator. With no applications running,
three icons are present. The topmost icon provides
access to the Web browser. The second icon pro-
vides access to the e-mail client, and the bottom
icon provides access to the other application
menus. This menu includes a menu option for just
about every feature of the 770. There are three
submenus: Utilities, Games and Extras. The Extras
submenu holds any optional software you might
install. Figure 3 displays the task navigator on
the far left, the other applications menu and
the utilities menu.

BROWSING THE WEB
Despite the fact that we are all now used to
browsing the Web with 17” or 19” monitors,
browsing the Web with the 770 is still an enjoy-
able experience, as illustrated by Figure 4. Clicking
on the globe from the Task Navigator gives you
the option to open a new browser window, man-
age bookmarks or select a specific bookmark. If
you want to enter a new URL, click on the address
field and type in or paste the new address. It took
me a while to figure out, but don’t worry about
typing in http:// before the address. Simply add
the address and click on the Go button. The
browser fills in the missing part.

If the site you are visiting contains content that
needs the Flash player, the 770 comes pre-
installed with a version 6-compatible Flash player. I
couldn’t resist trying it out, so I headed over to
http://homestarrunner.com to get a fix of Strong
Bad reading some e-mail. Although it was a bit
difficult to hear without plugging in some head-
phones, after switching to full-screen mode it
looked pretty decent.

Although the 770 does a great job of playing
Internet radio, I had problems getting it to play
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Figure 2. Easy Access to News, Radio and the
Web from the Home View

Figure 3. The Task Navigator, Other Applications
and Utilities Menus

Figure 4. The Opera Web Browser

http://homestarrunner.com
http://www.tuxmagazine.com


other music files when I went looking for them on
the Web. In some cases, it was unable to locate a
matching plugin and others were just not supported.
It seems that the best way to hear audio files is
to download them.

ADDING SOFTWARE
Even though the 770 is relatively new, a decent selec-
tion of additional applications is already available.
When Nokia announced its plans to build the 770
back in June 2005, it also announced the creation of
the open-source maemo development platform.
Initially, Nokia offered discount units for developers,
and it seems those efforts have been successful.

If you head over to http://maemo.org/maemowiki/
ApplicationCatalog, you will see a growing list of
applications built specifically for the 770. The list is
not overwhelming, but I think now that the 770 is
generally available, this list will grow.

While testing the 770, I was able to install sev-
eral applications successfully, including Gaim,
AbiWord and a general utility. Figure 6 shows the
results of the Gaim installation. Installation of

applications was so simple, I began wondering
why some of the more popular Linux distributions
couldn’t be more like the 770. There are two basic
ways to install new applications. First, you can
download the *.deb binary package and then copy
it over to the 770 using the USB connection. Then
from the control panel, use the application installer
to select the file. After installation, the new appli-
cation appears in the Extras menu option. If you
are fortunate to have the bandwidth, just install
the application straight from the Internet. After
clicking on the *.deb file, the file download dialog
should ask if you want to open the file with the
application installer. Select open, and the applica-
tion downloads. When it is complete, be sure to
select Ok and the 770 installs the application.

CONCLUSION
Despite the great user experience, the 770 is not
without its flaws. The first may be more of a prod-
uct or marketing decision, but the 770 comes with
only a pitiful 128MB of internal Flash memory.
Even the expansion RS-MMC cards available from
Nokia reach only 128MB. This is very disappoint-

ing. With the growing demand for downloadable
music, videos and movies, the 770 doesn’t leave
much room to play. I hope that Nokia finds a way
to squeeze in at least 2GBs in future models.

To complete my dream of a handheld laptop
replacement, future versions will have to include
the ability to display the video signal to an external
monitor. In addition, the Nokia 770 also will need
a presentation viewer. Although the 770 does not
provide some form of suspend or hibernate to save
my exact state, it does permit the user to put the
770 in standby mode. To enter standby mode,
remove (if not already removed) the metal protec-
tive case and place it over the screen of the 770.
This is convenient, because it lets me minimize
power consumption of the unit but still allows me
to pick right back up from where I left a task.

In terms of setup, ease of use, expandability
(except for memory), capability and support, the
770 scores very high. As a laptop replacement,
the price is good, but I really hope Nokia adds
additional memory soon. The documentation was
helpful, but I can’t wait for a Nokia 770 hacks
book to appear. I tested the 770 with an external
Bluetooth keyboard, and I’m convinced. I will try
to set up a unit to take on the road with me later
this year. I’ll let you know how it works out.�
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Figure 5. The Nokia 770 with the Flash-Enabled
Browser

Figure 6. The Gaim Instant-Messenger Application

$359.99 US
http://www.nokia.com/770

Kevin Shockey is Editor in Chief of TUX.

http://www.nokia.com/770
http://maemo.org/maemowiki/ApplicationCatalog
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Almost all of the desktop environments for Linux support themes that talent-
ed designers create and that we can download and install. On the two lead-
ing Linux desktop environments, GNOME and KDE, the elements that can be
altered through themes are:

� Window decorations (title bar, borders and so on).

� Icons (used on the desktop, menus and toolbars).

� Wallpapers (used as desktop backgrounds).

� GUI controls (buttons, drop-down boxes and so on).

� Splash dialogs (shown when loading the desktop).

Both desktops ship with a fairly reasonable number of themes for each of
these components, and you can download and install other themes from
Web sites such as KDE-Look.org (http://www.kde-look.org), or
http://art.gnome.org. The process of downloading these themes and
installing them, however, always has been a little tedious, because you need
to extract the theme archive at the proper place for your desktop to recog-
nize it, and this can be a little confusing for new users.

Fortunately, it appears that both desktops have come up with solutions to
this problem by allowing users to download and install themes directly from
the desktop, and not worry about the inner workings of this process.

On GNOME, a new utility called GNOME Art allows users to look for

Artwork for Your 
Linux Desktop
For a glimpse of the future of customization in GNOME and KDE, Xavier Spriet
compares the GNOME Art Manager and the KDE Control Center.

XAVIER SPRIET

Figure 2. Selecting a KDE Wallpaper

Figure 1. The GNOME Art Manager

http://www.kde-look.org
http://art.gnome.org
http://www.tuxmagazine.com


themes for any component of the desktop, preview and install them, with-
out ever loading their Web browser.

On KDE, currently only desktop backgrounds can be configured in that
way, but that is a good start. Users simply launch the KDE Control Center,
select the Wallpapers item and click the Download more Wallpapers button
in the dialog. A small utility will be launched that lets you look for wallpa-
pers sorted by popularity and age.

The GNOME Art utility is a little more complete. It can find, download
and install themes for every component of your desktop. You first need to
install the utility (it is available at http://www.miketech.net/gnome-art) and
launch it by typing gnome-art at the prompt. You then can click on the Art
menu entry and select the component for which you would like to find art-
work. The utility then downloads a list of items sorted chronologically, so if
you are looking for the latest entries, you need to scroll down the bottom of

that list.
You can either download a theme and save its archive somewhere, or you

can click the Install button once the theme of your choice is selected, and it
will be installed. The utility then launches the GNOME theme preferences
dialog, so you can activate that theme once it has been installed.

Although the GNOME Art manager utility hasn’t been around for very
long (since April 2005), some distributions are installing it automatically. To
find out whether the utility is already present in your system, click on the
Desktop→Preferences→Art Manager entry of your GNOME menu. If this
entry does not exist, you will have to download and install the utility first.�

Xavier Spriet is a software architect at Netmon, Inc., in Windsor, Ontario.
He is an avid reader and enjoys biking and traveling. You can reach Xavier
at xavier@wuug.org.
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Figure 3. Selecting a New Wallpaper for GNOME

Figure 4. Finding New Window Decorations for GNOME

http://www.miketech.net/gnome-art
mailto:xavier@wuug.org
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LINSPIRE MINI

http://www.linspire.com
$399 US (approx)

One of
the nicest
things
about the
Linux
operating
system is
that you
can run it
comfort-
ably on
hardware
that would turn Windows into a lumbering beast.
An upshot of this is a lot of people are able to
turn their old creaky Windows machines into
Linux boxes and keep that hardware in service for
a while longer. Luckily, hardware manufacturers
also have recognized that Linux’s ability to work
on more modest hardware makes it possible to
offer a brand-spanking-new computer at a rea-
sonably low cost.

What may not be so obvious is that the more

modest hardware requirements make it possible
for Linux to run fairly well on hardware that’s
been purposefully scaled back or condensed in
order to fit into a smaller form factor. Thus is born
the Linspire Mini. It’s clear that the Linspire Mini
took a lot of its inspiration from the Mac Mini,
Apple’s own ultra-compact computer. The basic
size and shape are almost identical, though the
2.8-pound Linspire box keeps the price down by
featuring a less snazzy industrial design. (Some
might call it kinda ugly, but really it’s just kind of
plain.) Because the unit is so compact, there’s not
much to see on the outside of the computer. The
front has a power button and a slot for the DVD-
ROM/CD-RW combo drive; the rear features two
USB ports, a FireWire connector, S-Video and DVI
video outputs, a 10/100 Ethernet port and speak-
er/mic jacks.

Inside, the Mini comes with a Pentium M 740
processor (or Celeron M), a single slot for DDR 2
memory, and a 40 or 80GB notebook-sized hard
drive. Wireless networking also is available inside
the box. Although the Linspire Mini comes with a
DVI-to-D-Sub monitor adapter, you’ll have to get
the monitor, keyboard and mouse separately.

Coming from Linspire, it’s no surprise that the
Mini runs the Linspire operating system. Right out

of the box, the Mini comes with music and photo
management software, Internet applications like
Firefox, e-mail and instant messaging capabilities,
as well as a number of built-in games. For the
more advance user, built-in BitTorrent file-sharing
software also is included. It’s almost everything
you need to get started in the world of Linux.

POWERSQUID CALAMARI

http://www.powersquid.net
$79 US

If you’re a gadget fanatic like I
am, eventually you’ll come to an
unpleasant realization. There are a
ton of gadgets out there—from
cell phones to organizers to MP3
players to digital cameras to what-
ever else—that feature power
adapters the size of small houses.
It takes only one or two of those
power bricks before you start
realize how badly designed
most power bars are.

The new PowerSquid
design aims to remedy that
problem, by breaking each of
the six power outlets out onto
its own tentacle to keep it from
interfering with your ability to
plug something in to the next
outlet over. Ultimately, the tentacles will sprawl
out a bit, but compared to having to string
together multiple power bars to get all those
power bricks hooked up, it’s a small price to pay.

The thoughtfulness of the design doesn’t stop

Gadget Guy Goes to CES 2006
SEAN CARRUTHERS

The Consumer Electronics Show, held annually at the beginning of January, is a treasure
trove of products for the gadget freak—big gadgets, small gadgets, phone gadgets, 
multimedia gadgets and even Linux gadgets. I had the chance to attend the show again
this year and got a look at a few new Linux-friendly products.
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there. At the end of the cord you plug in to your
wall outlet is a rotating head, allowing you to
reposition the cord so it doesn’t interfere with
other nearby outlets, without having the cord jut-
ting out from the wall itself. The Calamari model
also features power indicator lights inside two of
the outlets, allowing you to locate them easily,
even if the rest of the squid is tucked into a dark
corner behind your entertainment center.

PEPPER PAD PLUS

http://www.pepper.com
$849 US

Launched in summer 2005, the Linux-powered
Pepper Pad got a lot of attention for its combination
of portability and multimedia functionality; in fact,
TUX took a look at it in our debut issue (“The
Pepper Pad 2: First Impressions”, TUX,
March 2005). Now, meet the
Pepper Pad Plus.

Like the original Pepper Pad, the Pepper Pad
Plus is designed to be an instant-on handheld
wireless information center with a touch-sensitive
screen and mini-keyboard. It can be used to
surf the Web with the built-in Mozilla browser,
connect to the AOL Instant Messenger service,
send and receive e-mail, read eBooks, connect
with the Flickr photo-sharing service and show
off television schedules. You even can use it as
a remote control for your audio/video equip-
ment using the infrared port. This new version
of the Pepper Pad also includes Windows
Media compatibility and SIP-based VoIP
Internet telephony.

There have been a few hardware improve-
ments since the first generation. Although the
LCD screen holds steady at 8.4 inches, the inter-
nal hard drive has been bumped up to 30GB, the

Wi-Fi networking has been improved from
802.11b to 11g, and the Pepper Pad Plus

includes Bluetooth 2.0. Even better, the
battery life has been improved by 60%,
so you don’t have to hook it up to the
charger so often.

As before, data input may take a
bit of practice. The mini-keyboard is
split onto either side of the Pepper
Pad’s screen; media control but-
tons appear above the QWERTY
keys, and cursor and scroll con-
trollers appear below. You can
connect a whole variety of items

to the Pepper Pad via USB, or you
can insert a SecureDigital card directly into

the Pepper Pad Plus.
Linux developers also can create applications

for the Pepper Pad by registering at
http://www.pepper.com/linux.

PICOPSU-120

www.mini-box.com
$49 US

If you’re
planning to
build your
own compact
Linux server—
either for
home or for
the car—you
have to check
out the PicoPSU-120, which is the smallest
120-Watt power supply I’ve ever seen. In
fact, the entirety of the PicoPS-120 is
barely larger than the standard ATX power connector
that comes with most other power supplies.

The PicoPSU-120 features two full-size molex
power connectors and a floppy-sized connector. A
12-volt input jack sits at the end of a wire long
enough to reach the opposite side of a Mini-ITX
motherboard, so you have flexibility in power
location if you’re building your own chassis. Best
news of all: because it’s so small, it doesn’t need a
cooling fan, which means ultra-quiet operation.�

Sean Carruthers is a freelance technology
journalist from Toronto. He spent six
years at Canada Computer Paper, first as
Products Editor at The Computer and
later at HUB Digital Living magazine. As a
freelancer, he has written for the Globe
and Mail, http://globetechnology.com,

HUB Digital Living, Computer Dealer News, Homefront and
CE-Biz. Although a relative newbie with Linux (SUSE, thank
you very much), he has extensive experience with tech
gadgets of all sorts and is enjoying figuring out which ones
are compatible with Linux.
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